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                                                                               Preface

Preface

Welcome to the Trend Micro™ InterScan Web Security Suite 3.1 Installation Guide. 
This guide helps you to get “up and running” by introducing InterScan Web Security 
Suite (IWSS), assisting with deployment, installation, migration (if necessary), initial 
configuration, troubleshooting, performance tuning, and main post-installation 
configuration tasks. It also includes instructions on testing your installation using a 
harmless test virus, troubleshooting, and accessing Support.

This preface discusses the following topics: 
• Audience on page viii
• InterScan Web Security Suite Documentation on page viii
• Document Conventions on page ix
vii
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Audience
The IWSS documentation is written for system administrators in medium and large 
enterprises. The documentation assumes that the reader has in-depth knowledge of 
networks schemas, including details related to the following:
• HTTP and FTP protocols
• Database configuration

The documentation does not assume the reader has any knowledge of antivirus or 
anti-spam technology.

InterScan Web Security Suite Documentation
In addition to the Trend Micro™ InterScan Web Security Suite 3.1 Installation 
Guide, the documentation set includes the following:
• Administrator’s Guide—this guide provides detailed information about all 

InterScan Web Security Suite configuration options. Topics include how to 
update your software to keep protection current against the latest risks, how to 
configure and use policies to support your security objectives, and using logs and 
reports.

• Readme file—the Readme file contains late-breaking product information that is 
not found in the online or printed documentation. Topics include a description of 
new features, installation tips, known issues, and release history.
The latest versions of the Installation Guide, Administrator’s Guide, and readme 
file are available in electronic form at:

http://www.trendmicro.com/download/

• Online help—Helps you configure all features through the user interface. You 
can access the online help by opening the Web console and then clicking the 
help icon.

the purpose of online help is to provide “how to’s” for the main product tasks, 
usage advice, and field-specific information such as valid parameter ranges and 
optimal values. Online help is accessible from the InterScan Web Security Suite 
management console.
viii
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• Knowledge Base—the Knowledge Base is an online database of 
problem-solving and troubleshooting information. It provides the latest 
information about known product issues. To access the Knowledge Base, open:

http://esupport.trendmicro.com/support

The Administrator’s Guide and readme are available on the InterScan Web Security 
Suite CD and at http://www.trendmicro.com/download.

Document Conventions
To help you locate and interpret information easily, the InterScan Web Security Suite 
documentation uses the following conventions.

CONVENTION DESCRIPTION

ALL CAPITALS Acronyms, abbreviations, and names of certain com-
mands and keys on the keyboard

Bold Menus and menu commands, command buttons, 
tabs, options, and ScanMail tasks

Italics References to other documentation

Monospace Examples, sample command lines, program code, 
Web URL, file name, and program output

Note:
Configuration notes

Tip:  
Recommendations

WARNING!  
Reminders on actions or configurations that should be 
avoided
ix
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                                                                               Chapter 1 

Pre-installation Planning

This chapter explains the following:
• Server Requirements on page 1-2
• Information Needed to Install IWSS on page 1-4
• Planning Network Traffic Protection on page 1-9
• Planning HTTP and FTP Service Flows on page 1-13
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Server Requirements

Operating System
•  Windows 2000 Server with SP4 or above
•  Windows 2000 Advance Server with SP4 or above
•  Windows Server 2003 Enterprise/Standard Edition with SP2 or above
•  Windows Server 2003 R2 Enterprise/Standard Edition
•  Windows Server 2008 Enterprise/Standard Edition

Hardware Requirements
• Two Dual Core 2.79 GHz processors
• 2GB RAM 
• Disk space: 

•  1GB disk space for product installation
• 500MB disk space to install Microsoft SQL Server 2005 Express

• Monitor that supports 800 x 600 resolution at 256 colors or higher

Web Browser
To access the HTTP-based Web console, using any of the browsers in table Table 1-1.
TABLE 1-1.   Web Browser Requirements

Browser Windows Apple

2000 XP SP2 2003 Vista OS X

Internet 
Explorer 6.0

Supported Supported Supported X X

Internet 
Explorer 7.0

X Supported Supported Supported X

Firefox 2.0 Supported Supported Supported Supported X

Safari 2.0 X X X X Supported
1-2



Chapter 1: Pre-installation Planning
Other Requirements
• Database requirements:

• Microsoft SQL Server 2005, SQL Server 2005 Express, or SQL Server 2000
• MSDE 2000
• When using multiple IWSS Servers in a server farm configuration, Trend 

Micro recommends that you use separate server (possibly clustered) for 
Microsoft SQL 2005 Express

• If you choose to install SQL Server 2005 Express, Microsoft .Net      
Framework 2.0, MDAC 2.8, and Windows installer 3.1 are needed

• 1.7GB of disk space for every 3 million HTTP requests per day in order to 
maintain log files (calculation based on access logging enabled)

• 1GB RAM (based on access logging enabled)
• Internet Content Adaptation Protocol (ICAP):

• NetApp™ NetCache™ release 6.0.1
• Blue Coat Systems™ SGOS v5 (latest version) or above
• Cisco ICAP servers: CE version 5.3
• Any cache server that is ICAP 1.0 compliant

• Web Cache Communication Protocol (WCCP)
Trend Micro recommends using Cisco IOS versions:
• 12.2(0) to 12.2(22). Avoid using versions 12.2(23)
• 12.3(10), avoid using IOS versions from 12.3(0) to 12.3(9)

• Directory Servers:
To configure policies based on Lightweight Directory Access Protocol (LDAP) 
users and groups, IWSS can integrate with the following LDAP directories:
• Microsoft Active Directory 2000 or 2003
• Linux OpenLDAP Directory 2.2.16
• Sun™ Java System Directory Server 5.2 (formerly Sun™ ONE Directory 

Server)
• Control Manager Servers: 

To register IWSS with an existing Control Manager server on the network, Trend 
Micro recommends using Control Manager server versions:
1-3
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• TMCM server 3.0 SP6 and above 
• TMCM server 3.5 Patch 4 and above 

Further Requirements
• Administrator or Domain Administrator access to the server 
• IWSS clients must be able to access the HTTP port of the IWSS server that is 

selected during the installation
• IWSS server must be able to communicate via the client communication port 

during the install to all IWSS clients
• IWSS server and IWSS clients must be able to perform ICMP echo / reply 

sequences - either using the DNS name or IP address depending on the server 
selected during the install

• Do not install IWSS with other products of similar functions (such as Microsoft 
ISA server or Trend Micro InterScan Messaging Security Suite, etc.) on the same 
computer.

Information Needed to Install IWSS
You can either purchase IWSS or download a 30-day trial version of IWSS. The 
30-day trial versions provides all the functionality of IWSS.

The IWSS setup program prompts you for required information, depending on the 
options chosen during installation:

Type of HTTP Handler
Installing IWSS as a stand-alone proxy allows IWSS to act as the network's proxy 
server or work in conjunction with another proxy. Alternatively, you can configure 
IWSS to act as an ICAP server after installation.

For more information, see See Planning the HTTP Flow on page 1-14.
1-4
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Type of Proxy Configuration
The most common proxy configuration is to install IWSS as a forward proxy to 
protect clients from risks they might download from the Internet. Clients will have to 
modify their Internet connection settings to use the IWSS server as their proxy, 
unless you enable transparency. However, enabling transparency limits the user 
identification method to IP address and/or host name and may make some FTP links 
inaccessible.

Control Manager Server Information
If you plan to register IWSS with an existing Control Manager server on the network, 
you need to specify the server’s host name or IP address and the entity name of 
IWSS. Do not install IWSS on a TMCM server.

Database Type and Location
IWSS uses the Microsoft SQL Server database for report logs, policies, rules and 
configuration settings. Install an instance of SQL Server unless you already have an 
existing instance.

Fresh Install or Migration
Run setup.exe to install a fresh copy of IWSS on your server or upgrade IWSS 
to the latest version. If you want to upgrade IWSS, you will be prompted if you want 
to migrate data from the IWSS 2.5 version to IWSS 3.1. 

Multiple Instances of IWSS
You can install multiple instances of IWSS to handle high traffic-volume. When 
running more than one IWSS, there are a few things you need to know:
• Deploying multiple IWSS servers with a common database allows IWSS servers 

to share policies and configurations stored in the database. To share report and 
1-5
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log data store in the common database, select Database only or Database and 
log files in the Write logs to field in Logs > Settings > Reporting logs screen.  

FIGURE 1-1   Multiple IWSS Servers: Shared Database 

• If one instance of IWSS is installed as stand-alone, then all instances in the IWSS 
cluster must be stand-alone. Likewise, if one instance of IWSS is installed as an 
ICAP server, then all instances of IWSS in the cluster must also be installed as 
ICAP servers.

• Designate one instance of IWSS as "master" and all other instances as "slave" 
with the server farm option in the Administration > IWSS Configuration > 
IWSS Server Farm screen allows IWSS servers in the same server farm to share 
dynamic data stored in memory. Thus, when dynamic data is updated on a slave 
IWSS server, the slave server synchronizes the update with the master IWSS 
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server which in turn propagate the update to the other slave servers in the server 
farm. 

Note: Dynamic data include temporary blocked lists and the list of client IP addresses 
suspected of spyware infection. 
The master and slave designation settings in the IWSS Server Farm screen allow 
you to specify only how dynamic data is shared between multiple IWSS servers in 
a server farm. 

• To have all IWSS servers in a server farm share the same configuration files, 
install Trend Micro Control Manager. However, each IWSS server will still store 
its own configuration for the following: 
• Scan options, schedules, and notification messages
• Proxy server, LDAP, and other settings
• Update schedules 
• Log in password
• User ID method
• Individual scan engine, virus pattern, and URL Filtering database files
1-7
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Note: Trend Micro recommends that you use exactly the same settings for all IWSS 
servers in one server farm.

FIGURE 1-2   Multiple IWSS Servers: Control Manager 
1-8
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Planning Network Traffic Protection
To enforce the network traffic protection using IWSS, an additional solution 
(hardware, software or configuration) must be introduced that redirects the HTTP 
and/or FTP traffic to IWSS. Those solutions include:
• See Reconfiguring Client Settings on page 1-9
• See Using a Layer 4 Switch on page 1-10
• See Using an ICAP-enabled Proxy on page 1-11
• See Using a Router with WCCP version 2 on page 1-13

Reconfiguring Client Settings
HTTP clients (browser or proxy servers) can be configured to contact IWSS as a 
proxy. This configuration ensures that the FTP-over-HTTP traffic is forwarded to 
IWSS. The HTTP scanning service must be installed in the HTTP Proxy mode to 
process this traffic.

Set the following parameters in the [http] section of the pni file:
• transparency= no Disables transparent mode
• self_proxy= (yes|no)Depends on the traffic delivery requirements

FTP clients must contact IWSS instead of the destination server, and use a modified 
handshake to supply the FTP server address. The FTP scanning module must be 
installed and configured in standalone mode (proxy_mode=standalone) to process 
this traffic.
TABLE 1-2.   Reconfiguring the Client Settings

Advantage Limitation

No additional hardware required Administrator have to control settings for all 
computers. (Guest computers can have diffi-
culties.)
1-9
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FIGURE 1-3   Reconfiguring the Client Settings

Using a Layer 4 Switch
A Layer 4 switch can be used to redirect HTTP traffic to IWSS. The HTTP Scanning 
Service must be installed in the HTTP Proxy mode. 

Set the following parameters in the [http] section of the pni file:
• transparency=simple enables simple transparent mode
• self_proxy yes|no based on traffic delivery requirements
1-10
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FIGURE 1-4   Using a Layer 4 Switch

TABLE 1-3.   Using a Layer 4 Switch

Using an ICAP-enabled Proxy
Internet Content Adaptation Protocol (ICAP) is designed to forward HTTP 
response/request to third-party processors and collect the result. The component that 

Advantages Limitations

Transparent to clients Traffic interception must be port based (not 
protocol based) for one port. If the non-stan-
dard port is used for HTTP, it bypasses the 
switch.

Simple to establish The switch-based redirection cannot be used 
for the FTP traffic.

No LDAP support
1-11



Trend Micro™ InterScan™ Web Security Suite Installation Guide
sends the ICAP request is called the ICAP-client. A component that processes the 
request is called an ICAP-server.

When IWSS is configured in ICAP mode, it processes requests from any 
ICAP-compliant client. Officially, Trend Micro supports any ICAP 1.0 compatible 
server including NetCache, Blue Coat, and Cisco Content Engines (CE).

FIGURE 1-5.   Using an ICAP-enabled Proxy

TABLE 1-4.   Using an ICAP-enabled Proxy

Advantages Limitations

ICAP allows scanning of only new and necessary 
content.

Up front coast of ICAP resources

Reduced, selective scanning enhances perfor-
mance

Adds extra step in IWSS installation process

Increased resource efficiency reduces the num-
ber of IWSS server hardware needed

Requires management.
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Using a Router with WCCP version 2
The Web Cache Coordination protocol (WCCP) was introduced by Cisco to enable 
Cisco routers to communicate with Web traffic processing solutions 

IWSS also supports the Web Cache Coordination Protocol (WCCP 2.0), a protocol 
defined by Cisco Systems. The same limitations listed for simple transparency also 
apply to WCCP transparency, with the exception that FTP connections work and 
downloads via FTP are scanned. The benefits of WCCP transparency are support for 
multiple routers and automated reconfiguration for load balancing on router(s) when 
adding or removing IWSS servers.

Refer to Configuring Cisco Routers for WCCP Transparency on page 3-9 for more 
information. 

Planning HTTP and FTP Service Flows
Each HTTP and FTP configuration has implications for configuring IWSS, 
configuring the network, and for network security.

Create a flow plan for the HTTP and FTP services by doing the following:
• Understand each IWSS service’s purpose and function
• Determine each service's valid data sources. For example, does the HTTP service 

receive requests directly from the HTTP browsers, or indirectly through an ICAP 
proxy device?

• Determine which ports to use for the service. For instance, by default, the HTTP 
service uses port 8080, and the FTP service uses port 21. However, if another 
application or service is using port 8080, the administrator must configure the 
HTTP service to use a different port.

• Determine each service’s valid data destinations. For example, does the HTTP 
service send validated requests directly to the Web site? Or, does the HTTP 
service send the validated request to an upstream HTTP proxy?

• Add in any service-specific considerations. For instance, the HTTP service flow 
might include an ICAP device, but the FTP service flow does not. 

Using the information gathered above, administrators determine which one of the 
possible flows to use for the installation.
1-13
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Planning the HTTP Flow
The first step when planning HTTP flow for IWSS is choosing the type of handler:
• HTTP Proxy
• ICAP device

The flow involving an ICAP device is very different from those that do not involve 
ICAP devices.

There are five main possible flows:

For Forward Proxy Settings:
• Standalone mode—Use this flow when ICAP devices are not being used with 

IWSS, and IWSS connects directly to the Internet. This is the default flow 
created during installation.

• Dependent mode—Use this flow when ICAP devices are not being used with 
IWSS, and IWSS cannot connect directly to the Internet, but must instead 
connect through another HTTP proxy. This is can be accomplished in two ways:
• Proxy-ahead mode
• Proxy-behind mode (not recommended)
• Double-proxy mode

• Transparent proxy mode (simple transparency and WCCP)- Use this mode 
when clients computers are not configured to use the IWSS server as their default 
gateway, but still need to connect to the Internet through IWSS. 

For reverse proxy settings:
• Reverse proxy mode—Use this flow to protect a Web server with a proxy server 

by placing the HTTP proxy between the Internet and the Web server. (Used by 
ISPs and ASPs to protect the upload traffic against viruses and by organizations 
with complex Web sites that need a centralized point of access control.)

For ICAP proxy settings:
• ICAP protocol mode—Use the ICAP protocol flow to use ICAP devices with 

IWSS

Each configuration has implications for configuring IWSS, configuring the network, 
and for network security.
1-14



Chapter 1: Pre-installation Planning
HTTP Proxy in Standalone Mode
The simplest configuration is to install IWSS in stand-alone mode, with no upstream 
proxy. In this case, IWSS acts as a proxy server for the clients. Advantages of this 
configuration are its relative simplicity and that there is no need for a separate proxy 
server. A drawback of a forward proxy in stand-alone mode is that each client must 
configure the InterScan Web Security Suite device as their proxy server in their 
browser’s Internet connection settings. This requires cooperation from your network 
users, and also makes it possible for users to exempt themselves from your 
organization’s security policies by re-configuring their Internet connection settings.

Note: If you configure IWSS to work in stand-alone mode, each client on your network 
needs to configure Internet connection settings to use the IWSS device and port 
(default 8080) as their proxy server.

Web page requests follow this sequence:
1. The Web client sends a request to the HTTP service.
2. The HTTP service validates the request, if the URL is not blocked. If the URL is 

invalid (blocked), the HTTP service sends the HTTP client an appropriate notice, 
completing the transaction. If the URL is valid, the HTTP service attempts to 
connect to the applicable Web server.

3. The contacted Web site returns a response from the Web server to the HTTP 
service.

4. The HTTP service scans the content for unwanted data and returns the 
appropriate response to the client.

TABLE 1-5.   HTTP Proxy in Standalone Mode

Advantage Limitation

Simple to install and manage Slow connection reaches maximum allowed 
connections limit.
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Stand-alone Mode with Multiple Servers
Multiple IWSS servers can be installed to balance your network traffic and scanning 
load. In this installation example, a Layer 4 switch receives clients requests and then 
forwards them to the IWSS servers.

FIGURE 1-6.   Use a Layer 4 switch to load balance between IWSS 
servers for multiple HTTP stand-alone servers

HTTP Proxy in Dependent Mode (Proxy Ahead)
For HTTP browsers to use this flow, configure the browsers to proxy through the 
IWSS server, by default at port 8080.

Web page requests follow this sequence:
1. The Web client sends a request to the HTTP service.
2. The HTTP service validates the request. 

• If the URL is invalid (blocked), the HTTP service sends the HTTP client an 
appropriate notice, completing the transaction. 

• If the URL is valid, the HTTP service forwards the request to an upstream 
HTTP proxy server. 

3. The upstream proxy server performs its processing, then forwards the request to 
the Web site on the Internet 
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4. The contacted Web site returns a response (ideally a Web page) to the HTTP 
proxy server. 

5. The HTTP proxy server performs its processing on the returned data, then 
forwards the response data to the IWSS HTTP service. 

6. The HTTP service scans the content for unwanted data and returns an appropriate 
response to the HTTP client.

FIGURE 1-7.   HTTP Proxy in Dependent Mode (Proxy Ahead)

TABLE 1-6.   HTTP Proxy in Dependent Mode (Proxy Ahead)

Advantages Limitations

Proxy server controls timing and content avail-
ability behavior

IWSS has to scan every response-even if 
cached. 

It is more secure-configuration changes will affect 
cached objects.

IWSS does not wait for download of already 
cached objects.
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HTTP Proxy in Dependent Mode (Proxy Behind)
The proxy behind flow consists of a caching proxy placed between the HTTP client 
and the IWSS server without using ICAP. Organizations typically use this flow to 
increase performance, as with ICAP. 

WARNING!  Two security trade-offs exist for this potential performance enhancement:
1. If the cache contains data with a virus, for which there was no pattern 
when the data hit the cache, the IWSS HTTP service is powerless to prevent 
the spread of the virus. 
2. Similarly, if a policy regarding valid content changes, or unauthorized 
users request data that exists in the cache (for authorized users), the HTTP 
service is powerless to prevent subsequent unauthorized access to this data.

Instead of using the proxy-behind flow, Trend Micro recommends that administrators 
use an ICAP caching device. This solution provides the performance enhancements 
of caching without the security issues of proxy-behind topology.

Web page requests follow this sequence:
1. The Web client sends a request to HTTP proxy server.
2. The proxy server forwards the request to IWSS.
3. IWSS validates the request using URL Filtering/Blocking. 

• If the URL is invalid (blocked), the HTTP service sends the HTTP client an 
appropriate notice, completing the transaction. 

• If the URL is valid, the HTTP service forwards the request to the Web server 
on the internet. 

4. The contacted Web server returns a response (ideally a Web page) to IWSS. 
5. IWSS performs its processing on the returned data (virus, spyware, ActiveX 

scanning), then forwards the appropriate response/data to Proxy server. 
6. The Proxy server caches the data (if cacheable), then delivers the response/data 

to the HTTP client.
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FIGURE 1-8.   HTTP Proxy in Dependent Mode (Proxy Behind)

TABLE 1-7.   HTTP Proxy in Dependent Mode (Proxy Behind)

HTTP Double Proxy in Dependent Mode
Double proxy configuration requires two caching proxies. The first proxy is placed 
between the HTTP client and the IWSS server, and other one is placed between the 
IWSS server and the Internet. This is typically used to get the advantages of the two 
configurations of Dependent Mode: Proxy-ahead and Proxy-behind.

Web page request follows this sequence:
1. The Web client sends a request to first proxy server.
2. The first proxy server forwards the request to IWSS.

Advantages Limitations

No configuration changes required on the clients Configuration changes on IWSS affect 
cached objects

Cached objects are downloaded by clients 
directly from the Proxy server, which minimizes 
delays
1-19



Trend Micro™ InterScan™ Web Security Suite Installation Guide
3. IWSS validates the request using URL Filtering/Blocking. 
• If the URL is invalid (blocked) the HTTP service sends the HTTP client an 

appropriate notice, completing the transaction. 
• If the URL is valid, the HTTP service forwards the request to the second 

proxy server. 
4. The second proxy server performs its processing, then forwards the request to the 

Web server on the internet.
5. The contacted Web server returns a response (ideally a Web page) to second 

proxy server. 
6. The second proxy server caches the data (if cacheable), then deliver the 

response/data to IWSS.
7. IWSS performs its processing on the returned data (Virus, Spyware, ActiveX 

scanning), then forwards the appropriate response/data to first proxy server. 
8. The first proxy server caches the data (if cacheable), then delivers the 

response/data to the HTTP client.

FIGURE 1-9.   HTTP Double Proxy in Dependent Mode
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TABLE 1-8.   HTTP Double Proxy in Dependent Mode

HTTP Proxy in Transparent Mode
"Transparency" is the functionality whereby client users don't need to change their 
Internet connection's proxy settings to work in conjunction with IWSS. Transparency 
is accomplished with a Layer 4 switch that redirects HTTP packets to a proxy server, 
which then forwards the packets to the requested server. 

IWSS supports two types of transparency - "simple" transparency and the Web Cache 
Communication Protocol (WCCP). The benefit of enabling transparency is that 
clients' HTTP requests can be proceed and scanned by IWSS without any client 
configuration changes. This is more convenient for your end users, and prevents 
clients from exempting themselves from security policies by simply changing their 
Internet connection settings.

While it is compatible with a wide variety of network hardware from different 
manufacturers, configuring transparency does impose several limitations:
• When using simple transparency, the User Identification method to define 

policies is limited to IP address and/or host name; configuring policies based on 
LDAP is not possible.

• FTP over HTTP is not available; thus, links to ftp:// URLs may not work if your 
firewall settings do not allow FTP connections. Alternatively, links to ftp:// URLs 
may work, but the files will not be scanned.

• Transparency mode is not compatible with some older Web browsers when their 
HTTP requests don't include information about the host.

Advantages Limitations

Proxy server controls timing and content avail-
ability behavior

Costs more-- additional proxy server is 
needed

It is more secure-configuration changes will affect 
cached objects

IWSS does not wait for download of already 
cached objects

No configuration change required on the clients
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• HTTP requests for servers that use a port other than the HTTP default port 80 are 
redirected to IWSS. This means SSL (HTTPS) requests are typically fulfilled, but 
the content is not scanned.

• Do not use any source NAT (IP masquerade) downstream of IWSS, since IWSS 
needs to know the IP address of the client to clean.

• A DNS server is needed for DCS to resolve the client machine name from its IP 
address in order to perform a cleanup.

The benefit of enabling transparency is that clients’ HTTP requests can be processed 
and scanned by IWSS without any client configuration changes. This is more 
convenient for your end users, and prevents clients from exempting themselves from 
security policies by simply changing their Internet connection settings.
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HTTP Reverse Proxy in Dependent Mode
In reverse proxy mode, IWSS protects a Web server with the proxy server. The HTTP 
proxy is placed between the Internet and the Web server. This is useful when the Web 
server accepts file uploads from clients, or to reduce the load of each Web server by 
balancing the load among multiple Web servers. ASPs/ISPs use IWSS as an HTTP 
proxy to protect the upload traffic against viruses, and organizations with complex 
Web sites need it as a centralized point of access control.

This flow is especially useful for Web sites involved in e-commerce transactions, 
distributed applications, which exchange data across the Internet, or other situations 
where clients upload files to the Web server from remote locations.

In reverse proxy mode, the HTTP proxy acts as the Web server to the client systems. 
The proxy receives all requests and transfers them to the real Web server. 
Consequently, all HTTP traffic goes through the HTTP proxy, enabling the proxy to 
scan to content and block any infected transactions.

Note: Administrators should be aware of the following:
1. The URL-filtering feature makes no sense in this configuration; only anti-virus 
scanning and URL-blocking are useful.
2. In reverse proxy mode, the Web server's access log is useless. To analyze the 
connections for the Web site, you must use the proxy's access log.
3. Ideally, the reverse proxy server should be placed behind a firewall, but in many 
cases, the proxy is connected directly to the Internet, where it is more vulnerable to 
direct attacks. When a reverse proxy is configured without a firewall, 
administrators should take all appropriate precautions in securing the operating 
system hosting IWSS 

Web page requests follow this sequence:
1. Clients initiate Web request.
2. The request is received by InterScan Web Security Suite, configured to listen on 

port 80.
3. InterScan Web Security Suite scans the content, then forwards it to an actual Web 

server.
4. The Web server delivers the requested page back to IWSS.
5. InterScan Web Security Suite rewrites the page headers, and sends on the request.
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6. The modified page returns to the requestor.

FIGURE 1-10.   HTTP Reverse Proxy in Dependent Mode

TABLE 1-9.   HTTP Reverse Proxy in Dependent Mode

HTTP Proxy in ICAP Mode (Single and Multiple IWSS 
Servers)
This section discusses the flow of a typical HTTP GET request using both an ICAP 
device and IWSS servers. In these flows, IWSS interacts with the ICAP device, in 
response to ICAP rules. This is very different from other flows where IWSS receives 
URL requests form HTTP clients. To use these flows for HTTP browsers, configure 
the browsers to use the ICAP device as the HTTP proxy.

Using ICAP devices can enhance performance in two ways:
• Caching good data–If the data is clean, the ICAP device caches the data. 

Subsequent requests require only four steps, not eight. (ICAP must still ask 
IWSS to check the policies to validate that the users making the subsequent 
requests can browse the data, has not exceeded his or her quota, etc.)

Advantages Limitations

IWSS scans all objects only once-before they are 
cached

New engine, pattern, and configurations will 
not affect cached objects.

Access logging feature of IWSS is compro-
mised.
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• Clustered IWSS servers—When multiple IWSS servers are used, the ICAP 
device load balances the requests between the servers. This is vital for enterprise 
environments where the demand for scanning incoming pages can overwhelm a 
single IWSS server. With ICAP, the ICAP device performs load balancing, and 
receives maximum performance from the available IWSS servers.

Note: Non-ICAP environments can receive similar benefits by using multiple IWSS 
servers. However, the administrator must configure different users to proxy 
through the available IWSS servers and estimate how many and which clients to 
assign to each.

When IWSS is configured in ICAP mode, it processes requests from any 
ICAP-compliant client. Trend Micro supports any ICAP 1.0 compatible server 
including:
• NetCache
• Blue Coat
• Cisco Content Engines

Although IWSS performs the same filtering of URLs and scanning of data for 
unwanted content, the ICAP flow is so different from the other flows that it requires a 
completely different communications protocol. Administrators indicate which 
protocol (ICAP or non-ICAP) to use during post-installation configuration. 

The following figures show the HTTP flow with single and multiple IWSS servers. 
(Both images assume the requested data in not in the ICAP device's cache.) The 
ICAP service determines which IWSS server receives the request in a multi-server 
environment. 

Web page requests follow this sequence:
1. An HTTP client makes a request for a URL, sending the request to the ICAP 

caching proxy device.
2. The ICAP device, based on its configuration, determines that the request must be 

forwarded to an IWSS server. If multiple servers are available, it alternates in 
round-robin fashion for load balancing.

3. The IWSS server validates the URL.
• If the URL is not blocked, IWSS sends the response to the ICAP device. 
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• If the URL is invalid (blocked), IWSS directs the ICAP device to send an 
appropriate response to the HTTP client and the transaction is complete.

4. If the URL is valid, the ICAP server requests the page from the Web site on the 
Internet.

5. The Web site on the Internet returns the requested page (or some other 
appropriate response). 

6. If the page is returned, the ICAP device, based on its configuration, determines 
that an IWSS server must scan the data. Again, if multiple servers are available, it 
alternates in round-robin fashion for load balancing.

7. The IWSS server scans the results and returns an appropriate response to the 
ICAP device, based on whether the data is clean or contains unwanted content. 

8. If the data is clean, the ICAP device returns said data to the HTTP client, and the 
ICAP device retains a copy of the data to satisfy future requests. If the data 
contains unwanted content, the ICAP device returns an appropriate error message 
(dictated by IWSS) to the HTTP client, and the ICAP device does not retain a 
copy for future requests.

FIGURE 1-11.   HTTP Proxy in ICAP Mode (Single IWSS Server)
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IWSS ICAP Mode with Multiple Servers
If there is already a content cache server on your network, then Trend Micro 
recommends installing the ICAP HTTP handler. The following diagram shows the 
installation topology for IWSS ICAP with multiple servers. For multiple IWSS ICAP 
servers to work properly, their corresponding pattern, scan engine version, and 
intscan.ini files must be identical, and all servers should connect to the same 
database.

FIGURE 1-12.   HTTP Proxy in ICAP Mode (Multiple IWSS Servers)

TABLE 1-10.   HTTP Proxy in ICAP Mode

Advantages Limitations

No configuration changes required on the clients User identification on IWSS is not supported; 
thus, limited reporting

Cached objects are downloaded by clients 
directly from the Proxy server, which minimizes 
delays, and improves performance

Configuration changes on IWSS affect 
cached objects

Load-balancing possible after some configuration 
to the clients
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Planning FTP Flows
There are two possible FTP flows: standalone and dependent. They are similar to the 
stand-alone and dependent-mode flows for HTTP service. Each requires a different 
configuration and has its own implications including:
• Stand-alone—the IWSS server acts as an FTP proxy server between the 

requesting client and the remote site, brokering all transactions
• Dependent—IWSS works in conjunction with another FTP proxy server within 

a LAN

FTP Proxy in Standalone Mode
To scan all FTP traffic in and out of the LAN, set up the FTP scanning module so that 
it “brokers” all such connections. In this case, clients FTP to the IWSS server, supply 
the logon credentials to the target site, and then allow the IWSS FTP server to make 
the connection. The remote site transfers the files to IWSS FTP. Before delivering the 
files to the requesting clients, the IWSS FTP server scans the files for viruses and 
other security risks

The implications for the FTP standalone flow are:
• IWSS must have access to the target FTP servers
• There is one less step in the flow, compared to the FTP proxy mode

To configure FTP clients to use this flow:
• Set the IWSS server as a FTP proxy
• Set the user name to be username@targetftp-server, instead of the normal 

username

Note: IWSS FTP works with most firewalls, usually requiring only a modification to the 
firewall to open a port for the FTP proxy.

FTP requests follow this sequence:
1. The FTP client sends a request to the IWSS FTP service.
2. The IWSS FTP service validates the request (for example, the file type is not 

blocked). If the request is valid, the IWSS FTP service attempts to connect to the 
appropriate FTP server on the Internet. If the connection succeeds, the IWSS FTP 
service sends the request to the target FTP server.
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3. The FTP server on the Internet responds to the request, ideally with the requested 
file.

4. The IWSS FTP service scans the returned data for unwanted content. If it finds 
any unwanted content, it returns an appropriate message to the FTP client. 
Otherwise, it returns the requested data to the FTP client. 

FIGURE 1-13.   FTP Proxy in Standalone Mode

FTP Proxy in Dependent Mode
You can also install IWSS FTP on a dedicated machine between an upstream proxy 
and the requesting clients. Use this setup adds other FTP features (for example, 
access blocking, logging, and filtering) to supplement the existing FTP proxy.

IWSS's FTP-proxy mode, shown in Figure 1-14, is analogous to the dependent-mode 
flow of the HTTP service. Because it carries a performance penalty of an extra hop 
and extra processing by the other FTP proxy server, only use this mode if your 
organization does not allow the IWSS Server to access the Internet directly. 

If the other FTP proxy server uses a store-and-forward technique, the performance 
penalty is more noticeable on large files because the other FTP proxy first downloads 
the file and passes it on to the IWSS FTP service. Additionally, the other FTP proxy 
must have sufficient free disk space to hold all transfers in progress.
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Unlike the HTTP dependent-mode service, which has the possible benefit of cached 
requests, most FTP proxy servers do not cache requests.

FTP Dependent Mode also protects FTP servers from upload and download threats.

FTP requests follow this sequence:
1. The FTP client sends a request to the IWSS FTP service.
2. The IWSS FTP service validates the request (for example, the file type is not 

blocked). If the request is valid, the IWSS FTP service relays it to the other FTP 
proxy or the FTP server being protected by IWSS.

3. The FTP server on the Internet responds to the request, ideally with the requested 
file.

4. The IWSS FTP service scans the returned data for unwanted content. If it finds 
any unwanted content, it returns an appropriate message to the FTP client. 
Otherwise, it returns the requested data to the FTP client. 

FIGURE 1-14.   FTP Proxy in Dependent Mode
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                                                                               Chapter 2 

Deployment

This chapter explains the following:
• Operating Mode on page 2-2
• Identifying Your Server Placement on page 2-2
• Planning Network Protection and HTTP & FTP Service Flows on page 2-5
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Operating Mode
The main IWSS modules are run as Windows services to allow IWSS to handle 
multiple concurrent connections using input/output (IO) completion port technology. 

Identifying Your Server Placement
The first step is to identify the existing server where IWSS server should be installed. 
The second step is to identify the deployment options that exist, and eliminate those 
that do not fit the requirement.

Today's enterprise network topologies typically fall into one of two categories:
• Two firewalls with a Demilitarized Zone (DMZ) 
• One firewall without a DMZ. 

The ideal location for the IWSS server depends upon the topology in use.
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Two Firewalls with DMZ
Given today's security concerns, many organizations have implemented a topology 
consisting of two firewalls (one external and one internal). These firewalls divide the 
network into two main areas: 
• The DMZ—The DMZ is located between the external and internal firewalls. 

Hosts that reside in this area can accept connections from servers that are external 
to the organization's network. The configuration of the external firewall lets 
packets from external computers only reach servers inside the DMZ.

• Corporate LAN—These segments are located behind the internal firewall. The 
configuration of the internal firewall passes traffic to machines on the corporate 
LAN only when the traffic originates from computers inside the DMZ.

FIGURE 2-1   Two Firewalls with DMZ

This topology requires that all data inbound from the external servers (such as those 
on the Internet) first pass through a server in the DMZ. It also requires that certain 
types of data (for example HTTP and FTP packets), outbound from internal 
segments, pass through a server in the DMZ. This forces the use of proxies such as 
IWSS.
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One Firewall with No DMZ
Some organizations have a firewall, but no DMZ. When using the “no DMZ” 
topology place the IWSS server behind the firewall. 
• Because the IWSS server is not isolated from the corporate LAN, there is one 

less hop between external machines and machines on the corporate LAN. As 
shown in the diagram, this results in two less steps for processing a request, one 
outbound and one inbound.

• The firewall configuration allows connections to machines on the corporate 
LAN. For security, the firewall must limit the types of data that can reach 
machines on the LAN. For example, the firewall might allow HTTP data from 
the Internet to reach only the IWSS server.

FIGURE 2-2   One Firewall with DMZ
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Planning Network Protection and HTTP & FTP 
Service Flows

Network Traffic

To enforce the network traffic protection using IWSS, an additional solution 
(hardware, software or configuration) must be introduced that redirects the HTTP 
and/or FTP traffic to IWSS. Those solutions include the following:
• Reconfiguring client settings
• Using a Layer 4 switch
• Using an ICAP-enabled proxy

See Appendix A, Deployment Integration starting on page A-1 for complete details.

HTTP and FTP Service Flows

Each HTTP and FTP configuration has implications for configuring IWSS, 
configuring the network, and for network security.

Create a flow plan for the HTTP and FTP services by doing the following:
• Understand each IWSS services purpose and function
• Determine each service's valid data sources. For example, does the HTTP service 

receive requests directly from the HTTP browsers, or indirectly through an ICAP 
proxy device?

• Determine which ports to use for the service. For instance, by default, the HTTP 
service uses port 8080, and the FTP service uses port 21. However, if another 
application or service is using port 8080, the administrator must configure the 
HTTP service to use a different port.

• Determine each services valid data destinations. For example, does the HTTP 
service send validated requests directly to the Web site? Or, does the HTTP 
service send the validated request to an upstream HTTP proxy?

• Add in any service-specific considerations. For instance, the HTTP service flow 
might include an ICAP device, but the FTP service flow does not. 

Using the information gathered above, administrators determine which one of the 
possible flows to use for the installation.
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                                                                               Chapter 3 

Installing InterScan Web Security 
Suite

This chapter explains the following:
• Component Installation on page 3-2
• Pre-Installation Notes on page 3-3
• Installing InterScan Web Security Suite on page 3-3
• Post-Installation on page 3-8
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Component Installation

Note: Trend Micro recommends installing InterScan Web Security Suite on a dedicated 
server.

During installation, the following components are automatically installed:
• Main Program—Management console and the basic library files necessary for 

IWSS.
• HTTP Scanning—Service necessary for HTTP scanning (either ICAP or HTTP 

proxy) and URL blocking.
• FTP Scanning—Service necessary for FTP scanning.
• URL Filtering—Service necessary for URL filtering (not enabled by default). 

Requires a separate activation code.
• Applets and ActiveX Scanning—Service necessary for scanning Java applets 

and ActiveX controls. Requires a separate Activation Code.
• IntelliTunnel Security—Services to block communication provided by certain 

Instant Message (IM) protocols and certain authentication connection protocols.
• SNMP Notifications—Service to send SNMP traps to SNMP-compliant 

network management software.
• Control Manager Agent for IWSS—Files necessary for the Control Manager 

agent. You need to install the agent if you are using Control Manager (Trend 
Micro’s central management console).

Note: URL Filtering and Applets and ActiveX Scanning each require a separate 
activation code. 
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Pre-Installation Notes
• If you choose to use existing SQL Server for IWSS, the format of the database 

instance should be <IP address>/<instance name> or 
<hostname>/<instance name>. 

• For remote database access, IWSS supports only TCP/IP database connection 
type. 

• Trend Micro recommends you select Windows authentication if you want to 
install SQL Server 2005 Express. This allows IWSS to automatically connect to 
the database without you having to specify a login account credential and making 
sure the connection works. 

• You may use the database batch program (iniDB.bat) to initialize the database. 
For Windows authentication method, make sure you specify “]” as the user 
name and “[“ as the password. 

• Your DNS server must be able to resolve the IWSS host name to its IP address. 
You can do either of the following: 
• add an A record for the IWSS server on your DNS server
• add the appropriate entry to the hosts file in the folder 

%SYSTEM32%\drivers\etc 
An example entry would be:
{IP Address} {Hostname}

For example: 
10.1.1.1  iwsssrv

Installing InterScan Web Security Suite
Trend Micro recommends that you install InterScan Web Security Suite on a 
dedicated server. You can run the setup program to install or upgrade IWSS on a local or 
remote server. 

This section describes how to: 
• install IWSS 3.1 from the Enterprise Solutions CD
• install IWSS 3.1 by running the setup program
• install IWSS 3.1 through silent installation
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Installing from the Enterprise Solutions CD
Before you run the setup program from the CD, temporarily disable any pop-up 
window blocking feature or software on the server. 
To install from the Trend Micro Enterprise Solutions CD:

1. Insert the CD-ROM disc into the CD-ROM drive of the server where you want to 
install IWSS. If Autorun is not enabled, browse and open the file Start.htm 
in the home directory of the CD. 

2. Choose InterScan Web Security Suite and click Go. 
3. Select your Windows version, click Install, and follow the on-screen instructions 

to install IWSS. 

Installing by Running the Setup Program
You can copy the IWSS setup program from the Enterprise Solutions CD to the 
server or download the setup file from the Trend Micro product Web site. 

To run the setup program and install IWSS: 

1. In the folder where you saved the IWSS setup program, double-click 
setup.exe. 

2. Click Next in the Welcome screen. 

FIGURE 3-1   Fresh Install
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3. Select to accept the end-user license agreement and click Next. 

FIGURE 3-2   Fresh Install: License Agreement

4. Accept the default installation path or click Browse to choose a different folder. 
Click Next. 

FIGURE 3-3   Fresh Install: Choose Destination Location

5. In the Administrator Database Settings screen, select one of the following 
actions: 
• Install SQL Server 2005 Express: Choose this option if you do not have a 

database server installed on the server. The setup program installs the SQL 
Server after you click Next. By default the SQL Server creates a database 
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'iwss3' for IWSS with database instance name 'iwss' and uses Windows 
authentication method for database access. 

• Use an existing database server: Choose this option if you already have an 
instance of SQL server installed on the server. Specify the database in the 
format {IP}\{instance name} or {host name}\{instance 
name}.You will also need to specify the authentication method and type the 
account information. 

Note: IWSS supports only the TCP/IP connection type for remote database 
connection. 
Trend Micro does not recommend using Windows authentication. If you 
choose to use Windows authentication, you will need to specify the 
administrator account for all IWSS services to allow proper database 
connection. 
If you are using an existing database, make sure the account you specify has 
privilege to create and access the database, otherwise installation will be 
terminated. 
You can also use the InitDB.bat tool (located in the dbint folder in the 
installation package) to initiate the database separately. 

FIGURE 3-4   Fresh Install: Administration Database Settings

6. If you choose to install SQL Express 2005 and your server does not have 
Microsoft .NET Framework 2.0, click OK in the pop-up window to install 
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Microsoft .NET Framework 2.0 first. Setup will continue to install SQL Express 
2005. 

7. Review the installation settings and click Next to start installing IWSS. 

FIGURE 3-5   Fresh Install: Start Copying Files

8. After the installation is completed successfully, the Setup Status screen displays 
the default IWSS management console login user name and password. Click 
Next. 

FIGURE 3-6   Fresh Install: Setup Status
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9. After the installation is complete, select to restart your server and click Finish. 

FIGURE 3-7   Fresh Install: Install Complete

Silent Installation
You can also use the silent installation method to record and install IWSS on your 
computer. Type the install commands with the setup options and script in the 
command prompt. 

To record an installation script, type setup /r /f1"file" where "file" is the 
script file. You need to specify the file name and the complete path for the script file. 

To start silent install using an installation script file, type setup /s /f1"file" 
where "file" is the recorded script file.

Post-Installation 
After you finish installing, open the IWSS Web console and activate IWSS using the 
Activation Code to start using IWSS. You will need to use another Activation Code 
to activate other IWSS modules. 

Note: An activation code is required to enable scanning and product updates (see the 
Administrator’s Guide).
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Also note the following:
• Change the administrator login password to ensure the security of your system 

(see the Administrator’s Guide). 
• Trend Micro recommends that you update your scan engine and virus pattern 

files immediately after installing, registering and activating the product.
• Trend Micro only supports listening port 80 for IWSS in reverse proxy mode, as 

well as for the protected server. When configuring IWSS as a reverse proxy, 
specify port 80 in the "HTTP listening port "field, and in the "Port" field for the 
protected server. The IWSS listening port for reverse proxy is hard-coded to 80.

• Include the IWSS Web console URL to the local intranet or the list of trusted 
sites in your Web browser. 

• Make sure " localhost" is mapped to 127.0.0.1 in the Windows hosts file

Configuring Cisco Routers for WCCP Transparency 
IWSS supports WCCP transparency when used in conjunction with a Cisco router. 
This section provides a brief introduction to configuring a Cisco router so that it 
works with IWSS. 

IWSS supports the following WCCP features:
• WCCP version 2
• Generic Routing Encapsulation (GRE) HTTP and FTP packet redirection 

(L2-rewrite is not supported)
• Service number 80 
• HTTP (port 80) and FTP (port 21) are supported
• No password is supported

Note: Cisco IOS 12.2(23) through 12.3(9) has a known issue with WCCP connectivity. 
Trend Micro recommends not using these IOS versions. 

Cisco 2600 Router Configuration Example
Consider the following network as an example: 
• Two private network segments of 192.168.1.0/24 and 172.16.1.0/24
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• 192.168.1.0 is the network where clients reside
• 172.16.1.0 has IWSS and presumably other severs, and has access to the 

Internet through a firewall
• The two networks are connected by a Cisco 2600 series router
• The router’s FastEthernet 0/0 interface is connected to the 172.16.1.0 network 

with IP address 172.16.1.5 and FasEthernet 0/1 is connected to 192.168.1.0 with 
IP address 192.168.1.1

• 192.168.1.1 is the default gateway of the 192.168.1.0 network
• The IWSS server has IP 172.16.1.101

FIGURE 3-8   Network example: Cisco router and WCCP transparency 

Based on the network example, the Cisco router IOS command line configuration 
example is as follows: 

hostname(config)# ip wccp 80 redirect-list 101 group-list 22
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hostname(config)# access-list 22 permit 172.16.1.0 0.0.0.255

hostname(config)# access-list 101 permit tcp 192.168.1.0 
0.0.0.255 any eq www

hostname(config)# access-list 101 permit tcp 192.168.1.0 
0.0.0.255 any eq ftp

hostname(config)# interface FastEthernet0/0

hostname(config-if)# ip wccp 80 redirect out

hostname(config)# interface FastEthernet 0/1

hostname(config-if)# ip wccp 80 redirect in

In this example, 80 is the WCCP service number. IWSS always uses service ID 
number 80. 101 and 22 represent the access control list number for clients and the 
WCCP proxy respectively, so these numbers can be arbitrary. WCCP version 2 is the 
default configuration in IOS 12.2 and 12.3, and GRE redirection is the only 
redirection option for the Cisco 2600 router, thus it is not required to configure the 
WCCP version and redirection method. Note that there are other configuration 
possibilities. 

Note: For more detailed options about IOS commands, refer to your Cisco router 
documentation. 

Configuring IWSS to Use WCCP Transparency 
For this topology, you would configure the Proxy Scan Settings screen (HTTP > 
Configuration > Proxy Scan Settings) in the IWSS management console as follows: 
• Select Forward proxy
• Deselect Enable upstream proxy
• Select Enable transparency
• Select Enable Web Cache Coordination Protocol (WCCP)
• Specify the WCCP router's IP address: 172.16.1.5
• Specify the WCCP router port: 80

IWSS requires the GRE handler to receive WCCP GRE redirected packets correctly. 
THe GRE handler is a device driver included in the IWSS package and is copied to 
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the IWSS folder during installation. However, the GRE handler is not installed unless 
WCCP is chosen during installation. When WCCP is enabled via the management 
console, and the management console is opened from the server where IWSS is 
installed without any proxy server in between, the management console 
automatically installs the GRE handler on the IWSS server. A window relating to the 
GRE handler’s digital signature may display during installation–click Yes to continue 
the GRE handler installation. 

Note: Depending on its signature signing status, the security window may indicate that 
the GRE handler does not have any digital signature. 

If you try to connect to the IWSS management console from a remote computer, or if 
there is a proxy server between the browser and the IWSS server, the GRE handler 
will not be installed. Instead, a pop-up message displays advising you to install the 
GRE handler manually. In this case, the administrator must run the 
install_greh.exe command with the -i option from the Windows command 
line on the IWSS server. The installation program is copied to the <IWSS 
directory>\WCCP folder. The command to install the GRE handler from the default 
installation path is: 

<Install_directory>\WCCP\install-greh.exe -i

When installing the GRE handler from the command line, security messages are 
displayed in the same manner as installing through the management console. The 
install command can take the following parameters:

When the GRE handler is successfully installed, the network connection’s properties 
show the GRE Handler Driver is installed and enabled:

Parameter Action

(No parameter_ Show usage

-i Install

-u Uninstall

-e Enable

-d Disable
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FIGURE 3-9   Network properties after installing GRE handler

When WCCP is no longer used and is disabled in the management console, the 
management console either automatically uninstalls the GRE handler or prompts you 
to uninstall it by running install_greh.exe -u. The GRE handler can also be 
removed from the Local Area Connection Properties dialog box by selecting GRE 
Handler Driver and clicking Uninstall. 

Installing and removing the GRE handler does not require rebooting the server. 
However, the network connection may be affected and some applications, for 
example, Internet Explorer, that show remote host directories are affected. 

Testing IWSS
After installing IWSS, refer to Additional IWSS Testing on page B-1 to verify that the 
program is working properly. 
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                                                                               Chapter 4 

Migrating to InterScan Web Security 
Suite 3.1

This chapter explains the following: 
• About Migration on page 4-2
• Upgrading to IWSS 3.1 Using Setup on page 4-3
• Migrating to IWSS 3.1 Using the Migration Tool on page 4-6
• Rolling Back to Version 2.5 on page 4-9
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About Migration
You can migrate your InterScan Web Security Suite 2.5 release to version 3.1 with the 
installation program or the migration tool.

Note: You can only upgrade to version 3.1 from version 2.5. If you want to upgrade to 
version 3.1 from versions earlier than 2.5, you must first upgrade to version 2.5, 
then upgrade again to version 3.1.

Settings that Cannot be Migrated
IWSS automatically detects the existence of IWSS 2.5 on your computer and saves 
your configuration settings. 

The following settings will not be migrated.
• Outbreak Prevention Policy (OPP)
• Listening interface in intscan.ini if migrating between different computers using 

the migration tool. If you perform the migration on the same computer, the 
listening interface will be retained.

• Log and report files on local disk. You can choose to retain existing logs in the 
database in the setup screen. 

• Notification mails in queue
• Quarantine files. Trend Micro recommends you manually back up the quarantine 

files before migration. 
• Pattern and engine files. The included pattern and engine in the IWSS setup 

package will be applied after migration. Trend Micro recommends you perform 
an active update immediately after activating the product.

• SSL mode configurations for the IWSS Web console
• Specified port number of the Control Manager server. If the Control Manager 

agent uses a custom port number other than 80 or 443 to communicate with the 
Control Manager server, the port number information will not be retained and 
you will need to configure it again after the migration
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Backing Up IWSS 2.5 Information
Trend Micro recommends creating a back up copy of IWSS 2.5 configuration, 
policies, and logs. This allows you to roll back to IWSS 2.5 if an error occurs during 
program update or data migration. 
To back up IWSS 2.5 information: 

1. Stop the database services and IWSS related services. 
2. Make a backup copy of IWSS data files in the database folder. If you have 

installed MSDE using the IWSS 2.5 setup program, the files are located in the 
following folders by default: 
C:\Program Files\Trend 
Micro\Common\MSDE\Data\MSSQL\Data\iwss.mdf

C:\Program Files\Trend 
Micro\Common\MSDE\Data\MSSQL\Data\iwss_log.LDF

3. Make a backup copy of the IWSS 2.5 installation folder. The default path is 
C:\Program Files\Trend Micro\IWSS

4. Start the database before you migrate to IWSS 3.1. 

Upgrading to IWSS 3.1 Using Setup
If you want to upgrade IWSS from version 2.5 directly to version 3.1 on your 
computer, Trend Micro recommends you execute the setup program in the Enterprise 
Solutions CD.
To migrate to IWSS 3.1 using the Setup program:

1. Run the setup program. You can run the setup program from the Enterprise 
Solutions CD by double-clicking setup.exe. 

2. Click Next in the Welcome screen. 
3. Select to accept the end-user license agreement and click Next. 
4. In the IWSS Installation screen, select one of the following: 

• Fresh Install: choose this option to uninstall IWSS 2.5 before the setup 
program installs IWSS 3.1. 
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• Migrate from the old version of IWSS: choose this option to migrate data 
to IWSS 3.1. You may specify settings to back up old log data in the 
database. 

FIGURE 4-1   Migration: IWSS Installation Option

5. If you choose to migrate to IWSS 3.1, the setup program exports existing IWSS 
configuration and policies. You can choose whether to export old logs in the 
database. After the data export process is completed successfully, you can click Detail 
Log to view the results. Click Next to continue.

FIGURE 4-2   Migration: Export Finished
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Note: The log export process may take a few minutes depending on the size of the 
log data in the database.

6. In the IWSS Maintenance screen, select Uninstall IWSS from this machine. You 
may also select to delete the default MSDE DBMS or the current IWSS schema. 
Click Next. 

FIGURE 4-3   Migration: IWSS Maintenance

7. In the prompt screen, click OK to confirm the uninstallation. 

FIGURE 4-4   Migration: Uninstall IWSS 2.5

8. After IWSS 2.5 is uninstalled successfully, click Finish in the Maintenance 
Complete screen.

9. Setup continues to install IWSS 3.1 on your server. Refer to Installing by 
Running the Setup Program on page 3-4 for detailed installation procedure. After 
the installation is completed, the setup program imports data into IWSS 3.1. 

10. In the Install Complete screen, select to restart your server and click Finish.
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Migrating to IWSS 3.1 Using the Migration Tool
You can use the migration tool to export and import IWSS configurations. Trend 
Micro recommends using the migration tool if you want to migrate IWSS 2.5 
configurations from another computer or if you want to retain configuration in a 
server farm. The migration tool is located in the directory \migtool in the IWSS 
setup package. 

To migrate data using the migration tool, first use the migration tool to export the 
configurations from IWSS 2.5. After you have installed IWSS 3.1 on another 
computer, use the same migration tool to import the IWSS 2.5 configurations into the 
IWSS 3.1 computer.

Note: The export or import process may take up to several minutes depending on the size 
of the log data in the database. 

The migration tool is able to export/import the following IWSS information:
• Configuration files—INI configuration files, and IWSS system data 
• Policy—User-defined policy settings stored in the database
• Logs—IWSS Log data stored in the database
To export IWSS 2.5 configurations:

1. In the \migtool directory of the IWSS setup package, double-click 
MigrationGUI to run the program. 
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2. The IWSS Migration Tool screen displays. Select Export.

FIGURE 4-5   Migration Tool: Export

3. Select the IWSS configurations you want to export. 
4. Click Browse to select the directory to store the configurations. 
5. Click Export to start the configurations export process. 

To import IWSS 2.5 configurations:

1. In the \migtool directory of the IWSS setup package, double-click 
MigrationGUI to run the program. 
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2. The IWSS Migration Tool screen displays. Select Import. 

FIGURE 4-6   Migration Tool: Import

3. Select the IWSS configurations you want to import. 
4. Click Browse to select the directory where the configurations data is located. 
5. Click Import to start the configurations import process. 

Migrating to IWSS 3.1 in a Server Farm
If you deploy IWSS 2.5 in a server farm, you can still migrate IWSS 2.5 to IWSS 3.1. 
The migration method to use for server farm deployment depends on whether the 
IWSS servers share a common database. For more information about the server farm 
deployment methods, refer to Multiple Instances of IWSS on page 1-5. 

If the IWSS server farm does not share the same database, you can run the IWSS 3.1 
Setup program on each IWSS server to migrate IWSS 2.5 to IWSS 3.1 (refer to 
Installing by Running the Setup Program on page 3-4 for more information). 
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If all IWSS servers share the same database, follow the steps described below to 
migrate to IWSS 3.1:
1. Log in to an IWSS server in the server farm and use the migration tool to export 

local configurations, policy settings, and log data stored in the database. For 
more information on using the migration tool, refer to Migrating to IWSS 3.1 
Using the Migration Tool on page 4-6. 

2. On other IWSS servers, use the migration tool to export local configurations. 
3. Run the Setup program to install a fresh copy of IWSS 3.1 on all IWSS 2.5 

servers in the server farm. 
4. On the IWSS server (in Step 1), use the migration tool to import configurations, 

policy settings, and log data into the database. 
5. On other IWSS servers (in Step 2), use the migration tool to import the 

configurations. 

Rolling Back to Version 2.5
Currently, you cannot roll back to IWSS 2.5 using the IWSS Web console or 
commands. Before you start the roll back, make sure you have a backup copy of the 
IWSS 2.5 data. 

To roll back to the previous version:

1. Run the setup program to uninstall IWSS 3.1. 
2. Install IWSS 2.5.
3. Stop all database services and IWSS 2.5 related services. 
4. Replace the IWSS installation folder with the backup copy that you made before 

product migration. 
5. Replace the IWSS related database files with the backup copy that you made 

before product migration. 
6. Start the database services. 
7. Start IWSS 2.5 related services. 
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                                                                               Chapter 5 

ICAP Configuration

This chapter explains the following: 
• After Installing IWSS on page 5-2
• Setting up an ICAP 1.0-compliant Cache Server on page 5-2
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After Installing IWSS 
Perform these post-install configuration steps only if you have installed IWSS on 
your system.

After installing the IWSS program files, do the following:
1. Setting up an ICAP 1.0-compliant Cache Server on page 5-2
2. Enabling “X-Virus-ID” and “X-Infection-Found” Headers on page 5-8

Setting up an ICAP 1.0-compliant Cache Server
Configure an ICAP client to communicate with the ICAP server. 
• To set up ICAP for NetCache Appliance: on page 5-2
• To set up ICAP for the Blue Coat Port 80 Security Appliance: on page 5-4
• To set up ICAP for Cisco CE ICAP servers: on page 5-7

Setting up ICAP for NetCache Appliances
To set up ICAP for NetCache Appliance:

1. Log on to the NetCache console by opening http://{SERVER-IP}:3132 in a 
browser window.

2. Click the Setup tab, and then click ICAP > ICAP 1.0 in the left menu.
3. Click the General tab, and then select Enable ICAP Version 1.0. Click Commit 

Changes. 

Note: An error message “icap: This service is not licensed.” 
appears if you have not provided the required ICAP license key for NetCache.

4. Enter an ICAP license key:
a. Click the Setup tab, and then click System > Licenses in the left menu. The 

System Licenses screen appears.

b. Type IWFLPWA under the ICAP license section.

c. Click Commit Changes.
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5. Select the Service Farms tab on the ICAP 1.0 screen, and then click New 
Service Farm to add ICAP servers. Then, assign the service farm name in the 
Service Farm Name field.
• For response mode, select RESPMOD_PRECACHE in the Vectoring 

Point field
• For request mode, select REQMOD_PRECACHE in the Vectoring Point 

field
Select Service Farm Enable. 

6. In the Load Balancing field, choose the proper algorithm that you use for load 
balancing (if you have more than one ICAP server in the service farm). Clear 
Bypass on Failure. 

Note: Disable Bypass on Failure if the priority is more on virus propagation within 
your network. Otherwise, enable Bypass on Failure to guarantee an 
unblocked connection to the Internet.

7. Under the Consistency field, choose strong from the drop-down menu and leave 
the lbw Threshold field empty.

8. Under the Services text box (for response mode), type: 
icap://{ICAP-SERVER-IP}:1344/resp on, 
where ICAP-SERVER-IP is the IP address of IWSS ICAP for response mode.
Under the Services text box (for request mode), type 
icap://{ICAP-SERVER-IP}:1344/REQ-Service on, 
where ICAP-SERVER-IP is the IP address of IWSS ICAP for request mode.
For multiple IWSS ICAP server services, type the additional entries in step 7. For 
example:
For response mode,
• icap://{ICAP-SERVER1-IP}:1344/resp on

• icap://{ICAP-SERVER2-IP}:1344/resp on

Click Commit Changes.
For request mode,
• icap://{ICAP-SERVER1-IP}:1344/REQ-Service on
• icap://{ICAP-SERVER2-IP}:1344/REQ-Service on

Click Commit Changes.
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Note: For multiple ICAP servers within a service farm with strong consistency 
selected, make sure that all ICAP servers have identical intscan.ini and 
other configuration files and the same virus pattern. The service farm will not 
work properly if the ICAP servers have different configurations. 

9. Click the Access Control Lists tab, and then select Enable Access Control 
Lists. Type icap (Service Farm name of the ICAP Server) any in 
HTTP ACL. Click Commit Changes.
To configure scanning FTP over HTTP traffic, go to FTP > Configuration > 
Access Control Lists, and then add “icap (service farm name)” 
any into the FTP ACL field. 

Setting up ICAP for Blue Coat Port 80 Security Appliance
To set up ICAP for the Blue Coat Port 80 Security Appliance:

Log on to the management console by typing https://{SERVER-IP}:8082 in the 
address bar of your Web browser (specifying port 8082 as the default management 
port). For example, if the IP address configured during the first-time installation is 
123.123.123.12, enter the URL https://123.123.123.12:8082 in the Web browser. 
1. Select Management Console. Type the logon user name and password if 

prompted.
2. Click External Services > ICAP in the left menu.
3. Click New. The Add ICAP Service screen appears. 
4. In the ICAP service name field, type an alphanumeric name. Click Ok. 
5. Highlight the new ICAP service name and click Edit. The Edit ICAP Service 

name screen appears. 
6. Type or select the following information: 

a. ICAP version number (that is, 1.0)

b. The service URL, which includes the virus-scanning server host name or IP 
address, and the ICAP port number. The default ICAP port number is 1344. 

• Response mode:
icap://{ICAP-SERVER-IP}:1344 

• Request mode:
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icap://{ICAP-SERVER-IP}:1344/REQ-Service

where ICAP-SERVER-IP is the IP address of IWSS ICAP.

c. The maximum number of connections (ranges from 1-65535). The default 
value is 5.

d. The connection timeout, which is the number of seconds the Blue Coat Port 
80 Security Appliance waits for replies from the virus-scanning server. The 
range is an interval from 60 to 65535. The default timeout is 70 seconds.

e. Choose the type of method supported (response or request modes).

f. Use the default preview size (bytes) of zero (0).

g. Click Sense settings to retrieve settings from the ICAP server 
(recommended).

h. To register the ICAP service for health checks, click Register under the 
Health Check Options section.

7. Click Ok, and then click Apply.

Note: You can edit the configured ICAP services. To edit a server configuration 
again, select the service and click Edit. The examples used for configuring 
ICAP for Blue Coat is based on SGOS version 5.2.2.5. The settings may vary 
depending on the version of Blue Coat.

8. Add response or request mode policy. 
The Visual Policy Manager requires the Java 2 Runtime Environment Standard 
Edition v.1.6.0 or later (also known as the Java Runtime or JRE) from Sun™ 
Microsystems, Inc. If you already installed JRE on your workstation, the 
Security Gateway opens a separate browser window and starts the Visual Policy 
Manager. The first time you start the policy editor, it displays an empty policy. 
If you have not installed JRE on your workstation, a security-warning window 
appears. Click Yes to continue. Follow the instructions to install the JRE. 

To add the response mode policy: 

a. Select Management Console. Type the logon user name and password if 
prompted.
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b. Click Policy in the left menu, and then click Launch to start Blue Coat 
Visual Policy Manager. 

c. The Blue Coat Visual Policy Manager screen displays. Click Policy > Add 
Web Content Policy. the menu bar, click Edit > Add Web Content Policy 
to display the Add New Layer pop-up screen. 

d. Type a descriptive name in the Layer Name field and click OK.

e. Under the Action column, right-click Set. The Add Object screen appears. 
Click New and select Set ICAP Response Service. The Add ICAP 
Response Service Object screen appears.

f. Choose the ICAP service name under the Use ICAP Response Service 
field. Enable Deny the request under the Error Handling section. Click 
OK, and then click OK again.

g. Click Install Policies.

To add the request mode policy: 

a. Select Management Console. Type the logon user name and password if 
prompted.

b. Select Policy in the left menu, and then click Launch to start Blue Coat 
Visual Policy Manager. 

c. The Blue Coat Visual Policy Manager screen displays. Click Policy > Add 
Web Content Policy. the menu bar, click Edit > Add Web Content Policy 
to display the Add New Layer pop-up screen. 

d. Type the policy name in the Layer Name field. Click OK.

e. Under the Action column, right-click Set. The Add Object screen appears. 
Click New and select Set ICAP Request Service. The Add ICAP Request 
Service Object screen appears.

f. Choose the ICAP service name under the Use ICAP Request Service field. 
Enable Deny the request under the Error Handling section. Click OK, 
and then click OK again.
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g. Click Install Policies.

FIGURE 5-1   Configure both the request and response mode ICAP 
services. To check the current policy, go to the 
“Policy” screen, click “View” > “Current SG 
Appliance VPM Policy File”. 

Setting up ICAP for Cisco CE ICAP Servers
To set up ICAP for Cisco CE ICAP servers:

IWSS supports Cisco ICAP servers (CE version 5.1.3, b15). All ICAP settings are 
performed through a command line interface (CLI); there is no user interface 
associated with the Cisco ICAP implementation.
1. Open the Cisco CE console.
2. Type config to enter the configuration mode.
3. Type ICAP to display a list of all ICAP-related commands.
4. Create a response modification service, by typing 

icap service RESPMOD SERVICE NAME

This takes you into the ICAP service configuration menu. Display a list of all 
available commands. Type the following commands:
server icap://ICAP SERVER IP:1344/resp (to assign a server type)
vector-point respmod-precache (to assign the proper vector point type)
error-handling return-error (to assign the proper error-handling type)
enable (to enable the ICAP multiple server configuration)
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5. Type exit. 
6. Create a request modification service, by typing

icap service REQUESTMOD SERVICE NAME

This command takes you into the ICAP service configuration menu. Display a 
list of all available commands. Issue the following commands:
server icap://ICAP SERVER IP:1344/REQ-Service (to assign a server 
type)
vector-point reqmod-precache (to assign the proper vector point type)
error-handling return-error (to assign the proper error-handling type)
enable (to enable the ICAP multiple server configuration)

7. Type exit.
8. For additional configuration steps, type the following:

icap append-x-headers x-client-ip (to enable X-client headers for 
reports)
icap append-x-headers x-server-ip (to enable X-server headers for 
reports)
icap rescan-cache ISTag-change (to turn on ISTAG rescan for updates)
icap bypass streaming-media (to exclude streaming media from ICAP 
scanning)
icap apply all (to apply all settings and activate ICAP type)
show icap (to display current ICAP configuration at root CLI menu)

Enabling “X-Virus-ID” and “X-Infection-Found” Headers
IWSS can return 2 optional headers from the ICAP server whenever a virus is found: 
the “X-Virus-ID” and the “X-Infection-Found” headers. Neither of these headers are 
returned by default for performance reasons, since many ICAP clients do not use 
these headers. They must be enabled in the IWSS management console.
• “X-Virus-ID” contains one line of US-ASCII text with a name of the virus or risk 

encountered. For example:

X-Virus-ID: EICAR Test String
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• “X-Infection-Found” returns a numeric code for the type of infection, the 
resolution, and the risk description.

For more details on the parameter values, see:

http://www.i-cap.org/spec/draft-stecher-icap-subid-00.txt

To enable the X-Virus-ID header:

1. From the main menu, click HTTP > Configuration > Proxy Scan Settings.
2. On the Proxy Settings page, select Enable 'X-Virus ID' ICAP header and/or 

Enable 'X-Infection-Found' ICAP header.
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                                                                             Appendix A 

Deployment Integration
This appendix explains the following: 
• IWSS in a Distributed Environment starting on page A-2
• Integration with LDAP starting on page A-3
• Damage Cleanup Services (DCS) Integration starting on page A-5
• Integration with Cisco Router starting on page A-7
• Protecting an HTTP or FTP Server starting on page A-8
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IWSS in a Distributed Environment
IWSS is designed to be part of a distributed system and can establish a number of 
network connections based on the configuration settings.

The administrator must ensure the following:
• None of the required channels are blocked
• All channels have enough throughput
• Servers use a supported version of the software
• Servers have enough performance

Connection Requirements and Properties
Table 1-1 below gives the required connections and their properties.

TABLE 1-1.   Required Connections and Properties

Connecting Component Traffic: Type and Volume If the Connection is lost

Clients Should be measured on the real 
network

No protection

Database server Type: TCP

Volume: 
• Low—if access logging is 

disabled
• Medium—if access 

logging is enabled

Cached data is used for 
already started services.

Services will not start.

LDAP server (if configured) Type: LDAP

Volume: Medium

Cached data is used for 
already started services.

Services will not start.

Trend Micro Active Update 
Server

Type: HTTP and HTTPS

Volume: 10-50 Mb/day

IWSS components cannot 
be updated in time.

Trend Micro Dynamic Categori-
zation server (if configured)

Type: HTTP

Volume: Depends on the spe-
cific access

Requested resources are 
not categorized properly. 
URLs prohibited by policy 
settings can be accessible.
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Throughput and Availability Requirements
The administrator must determine the IWSS availability requirements. 
• Is IWSS downtime acceptable?
• If so, what is the proper action (bypass or stop) to enforce when IWSS is down?
• If a failover configuration with multiple IWSS instances is used, do the LDAP 

server and the database server have the same level of failover?

Integration with LDAP

Support Referral Chasing for Multiple LDAP Servers
IWSS has an LDAP module that allows communication with multiple LDAP servers 
with the ability to establish multi-domain tree- and forest-like environments.

If the configured main LDAP server from the IWSS Web console HTTP > 
Configuration > User Identification page cannot resolve client credentials, and the 
“referral chasing” is enabled (providing that the referral server(s) is configured), 
IWSS attempts to query for the requested User/Group object with the configured 
Primary Referral Server. If the queried object is still not found, a configured 
Secondary Referral will be queried. In order to do that, it must keep the credentials of 
the administrative account for all LDAP servers in the [LDAP-Setting] section of 
the intscan.ini file.

The Windows Active Directory (AD) Global Catalog enables LDAP clients, such as 
IWSS, to query objects native to the domain being queried, and those residing in 
remote domains, as long as the AD server being queried and the remote AD server 
has Global Catalog enabled. The Global Catalog server accepts the LDAP requests 
on port 3268 and allows querying the user credentials, full name and membership in 

Trend Micro DCS server 
(if configured)

Type: HTTP

Volume: Depends on the num-
ber of infected machines

No cleaning is performed 
for infected machines.

TABLE 1-1.   Required Connections and Properties (Continued)

Connecting Component Traffic: Type and Volume If the Connection is lost
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the global and universal groups across all other domains in the forest. The use of the 
Global Catalog is handy when creating IWSS LDAP policies for a parent group with 
user(s)/group(s) member(s) residing on remote domains that are part of many 
sub-domain levels.

To use this feature, the IWSS administrator should configure the main LDAP server 
that IWSS uses from the Web console HTTP > Configuration > User 
Identification page to communicate with a designated Global Catalog-enabled 
Active Directory server using port 3268, instead of using the default LDAP 
communication port 389.

Note: Global Catalog is available only in Microsoft Active Directory. The advantage of 
using the Global Catalog port includes better performance for LDAP object 
lookup, and allows object lookup that resides in many sub-levels of the Active 
Directory tree (beyond three). However, in order for IWSS to utilize the Global 
Catalog, the AD being requested for an object needs to have the Global Catalog 
enabled along with the AD where the queried user/group object reside. IWSS 
supports the use of the Global Catalog port only to be configured as the main 
LDAP server, and not part of the IWSS referral chasing servers.

Tip:  Trend Micro recommends allowing IWSS to query the root Active Directory 
server with the Global Catalog enabled, and using Universal group types to do 
group nesting when applying policies. This can be seen by the Global Catalog and 
will be visible throughout the Active Directory. For more information, see 
Microsoft support (http://support.microsoft.com/kb/231273).

Guest Account
When LDAP support is enabled, IWSS works in the authenticated proxy mode. It 
requires authentication for every client. This rule can cause problems for 
guest/mobile computers, whose users are not registered in the local LDAP server.

To resolve this issue, the HTTP scanning service in the HTTP proxy mode supports 
an additional listening point that can be used as a proxy server specification for the 
guest computers.

The following configuration parameters control this behavior:
A-4



Appendix A: Deployment Integration
• intscan.ini/[http]/guest_user_login enable guest port
• IWSSPIProtocolHttpProxy.pni/[main]/guestportport number on 

which to listen

IWSS bypasses the LDAP-based user identification and applies the special (Guest) 
policies to every computer accessing it over this port.

Damage Cleanup Services (DCS) Integration
While IWSS can detect and block worms and spyware at the HTTP and FTP 
gateway, it can also work in conjunction with Trend Micro Damage Cleanup 
Services to clean infected clients. Damage Cleanup Services is a comprehensive 
service that helps assess and clean system damage without installing software on 
client computers in a network. It performs the following activities:
• Removes registry entries created by worms and Trojans
• Removes memory resident worms, Trojans, and spyware/grayware
• Repairs system file configurations modified by malware

After IWSS is registered with one or more DCS servers, IWSS issues a cleanup 
request if it detects one of the following trigger conditions:
• Client PC attempts to access a URL classified as “Spyware,” “Disease Vector,” 

or “Virus Accomplice” by the Phish pattern file, or
• Client PC uploads a virus classified as a worm
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Note: If malware attempts to contact a remote server using a protocol other than HTTP, 
IWSS will not detect it, thus will not trigger a cleanup.

FIGURE A-1   How IWSS requests DCS to perform a client cleanup

When IWSS registers to a DCS server, infected client cleanups are handled in the 
following manner:
1. IWSS detects the client attempting to access a URL listed in the PhishTrap 

pattern file or upload a worm.
2. IWSS requests the DCS server to clean up the infected client.
3. DCS attempts to connect to the infected client and clean it through remote 

procedures.
4. DCS reports the outcome of its cleaning attempt to IWSS for logging.

When it receives a cleanup request from IWSS, DCS attempts to connect to the 
infected client and repair the system damage. The outcome of the cleaning attempt, 
either successful or unsuccessful, is reported back to the IWSS server for logging. If 
the cleanup attempt is not successful, then the client is redirected to a Web page 
hosted on the DCS server and an ActiveX control again attempts to clean the infected 
computer, with the permission of the computer’s user.
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Integration with Cisco Router
You can integrate IWSS on a network that uses a Cisco router at the gateway without 
changing the browser settings of the client machines.

To resolve the issue, integrate IWSS on the network through transparent proxy 
configuration by setting up the Policy-based Routing (PBR) on the Cisco router with 
the following policies:

Policy 1 Conditions:
• If the packet is from the IWSS server
• If the packet is for port 80/tcp and/or 443/tcp

Action: Routes the packet to the Internet.

Policy 2 Conditions:
• If the packet is from the local area network (other than the IWSS server)
• If the packet is for port 80/tcp and/or 443/tcp
• If the packet is not from the IWSS server

Action: Forwards the packet to the IWSS proxy port

For information on configuring policy-based routing, refer to the Cisco Online 
Configuration Guide.

Note: In IWSS 3.1, set IWSS to transparent proxy when implementing this setup. For 
additional information, see Using an ICAP-enabled Proxy starting on page 1-11.
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Protecting an HTTP or FTP Server
If you are protecting the HTTP server, install the HTTP scanning service in the 
HTTP proxy mode and use the reverse proxy configuration.
• Define the following configuration setting in the [http] section of the pni-file 

IWSSPIProtocolHttpProxy.pni:
• self_proxy=reverse—specifies operation mode
• reverse_server—specifies the IP address of the protected HTTP server
• reverse_server_port—specifies the TCP port of the protected HTTP 

server

Note: To simplify the deployment of the reverse-proxy configuration in an 
HTTP/HTTPS environment, IWSS can listen for the incoming (HTTPS) 
connection on a port specified by the [main]/secondaryport 
configuration parameter, and forward this traffic without scanning to port 443 
of the protected server.

FIGURE A-2   Protecting a Dedicated Server

If you are protecting the FTP server, install the FTP scanning service and configure 
it to use an FTP proxy.
A-8



Appendix A: Deployment Integration
• Define the following configuration setting in the [ftp] section of the pni-file 
IWSSPIProtocolFtp.pni:
• proxy_mode=dedicated — specifies operational mode
• ftp_server — specifies the IP address of the protected FTP server
• ftp_server_port — specifies the TCP port of the protected server
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                                                                             Appendix B 

Additional IWSS Testing 
In appendix explains the following:
• Testing Upload Scanning on page B-2
• Testing FTP Scanning on page B-2
• Testing URL Blocking on page B-4
• Testing Download Scanning on page B-5
• Testing URL Filtering on page B-5
• Testing Spyware Scanning on page B-6
• Testing PhishTrap on page B-7
• Testing Java Applet and ActiveX Scanning on page B-8
• Testing IntelliTunnel Security on page B-9
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Testing Upload Scanning
Trend Micro recommends that you test virus scanning of Web-based mail 
attachments. 

To test virus scanning of Web-based mail attachments:

1. Open the IWSS console and click HTTP > Scan Policies in the main menu. 
Clear Enable virus scanning, and then click Save.

2. Download the test virus from the following page: 

http://www.eicar.org/anti_virus_test_file.htm 

3. Save the test virus on your local machine.
4. Re-open the IWSS console, under HTTP > Scan Policies in the main menu, 

select Enable virus scanning, and then click Save.
5. Send a message with one of the test viruses as an attachment by using any 

Internet mail service. A message similar to the following should display in your 
browser.

FIGURE B-1   This warning screen shows the detection of an EICAR 
test virus.

Testing FTP Scanning
The following procedure contains instructions to test FTP virus scanning in 
stand-alone mode.

To test virus scanning of FTP traffic:

1. Download the test virus from the following page:
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http://www.eicar.org/anti_virus_test_file.htm

2. Access the FTP server through IWSS working as the FTP proxy. 
For example, assume the following IP addresses: IWSS FTP proxy server 
(10.2.10.2), FTP server (10.2.10.10). 
Open a command line prompt and type the following:

ftp 10.2.10.2 

3. Log on as user@host. For example, if your FTP account name is anonymous 
and the IP address of the FTP server is 10.2.10.10; then, log on as 
anonymous@10.2.10.10 

4. Upload the test virus (for example, eicar_com.zip) by typing the command

put eicar_com.zip

5. If you have configured the IWSS FTP proxy correctly, IWSS displays a message 
similar to the following.

FIGURE B-2   This is a warning message that shows the detection of a 
virus in eicar_com.zip.
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Testing URL Blocking
Before testing URL blocking, require your users to set the Web client’s HTTP proxy 
to point to IWSS. 
• For stand-alone mode, set the Web client’s HTTP proxy to point to IWSS (for 

example, open Internet Explorer and click Tools > Internet Options > 
Connections > LAN Settings > Use a proxy server).

• For upstream proxy, set the Web client’s HTTP proxy to point to IWSS (for 
example, open Internet Explorer and click Tools > Internet Options > 
Connections > LAN Settings > Use a proxy server). Open the IWSS console 
and click HTTP > Configuration > Proxy Scan in the left menu and enable 
Dependent mode. Type the proxy address and the port number.

To test URL blocking:

1. Open the IWSS console and click HTTP > URL Access Control > URL 
Blocking in the main menu and select Enable URL blocking. 

2. In the Match field, type the full Web address, URL keyword, or exact-match 
string. 

3. Click Block, and then click Save. 
4. Open a Web browser and try to access the blocked Web site, a URL containing 

the string, or the exact-match string. A message similar to the following displays 
in the browser.

FIGURE B-3   A sample warning message for a blocked URL site.
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Testing Download Scanning
To test virus scanning when downloading using HTTP or FTP over HTTP, attempt to 
download the test virus from the following Web site:

http://www.eicar.org/anti_virus_test_file.htm

FIGURE B-4   The above virus-warning screen displays if the system is 
set up properly.

If a client attempts to download an infected file, IWSS blocks other clients’ access to 
that site for four hours by default. When other clients subsequently attempt to access 
the same URL that contained the virus, the user will see a URL blocking message 
instead of the virus-warning message. 

Configure the default block time (in hours) by changing the parameter 
infected_url_block_length under the 
[Scan-configuration] section of the intscan.ini file.

Testing URL Filtering
Trend Micro recommends that you use the default setting to test URL filtering.
To test URL Filtering:

1. Click HTTP > URL Filtering > Settings. 
2. From the Approved URL List tab, review the Web site categories that are 

classified as “Approved URL List.”
3. From the main menu, click HTTP > URL Filtering > Policies. 
4. Select Enable URL filtering and then click Save.
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5. Click URL Filtering Global Policy and verify that the appropriate categories are 
blocked during work and leisure time. 

6. Open a browser and access any site (for this example, 
www.urlfilteredsite.com), which is specified in a prohibited category.

FIGURE B-5   The following message appears if the URL filtering is set 
up properly.

Testing Spyware Scanning
Perform the following procedure to test for spyware scanning.
To test Spyware scanning:

1. Open the IWSS console and click Summary.
2. Click the Scanning tab.
3. Enable spyware and other grayware categories for scanning by clicking HTTP 

scanning.
4. Click HTTP > Scan Policy.
5. Click the Spyware/Grayware tab and select the types of spyware/grayware 

which should be scanned.
6. Click the Action tab.
7. Under the Uncleanable files field, select the action setting (Delete, Quarantine, 

or Pass).
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8. Click Save.
9. After a successful spyware detection, a sample message appears:

FIGURE B-6   A sample message after detecting a spyware with action 
“Delete” setting.

Testing PhishTrap
Perform the following procedure to test PhishTrap.
To test Phishtrap scanning:

1. Open the IWSS console and click HTTP > URL Access Control > URL 
Blocking.

2. Select Enable URL blocking.
3. Click the Via Pattern File (PhishTrap) tab.
4. Under Block the following PhishTrap categories, select all four categories 

(Phishing, Spyware, Virus accomplice, Disease vector).
5. Click Save.
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6. After a successful phishing site detection, a sample message appears:

FIGURE B-7   A sample message after detecting a phishing site.

Testing Java Applet and ActiveX Scanning
Java applets and ActiveX controls are used on many Web pages to display interactive 
content or applications. One way to test your installation is to temporarily configure 
the global policy to block all applets and ActiveX controls, and then attempt to open 
Web pages that use them (to verify that the applet or object is blocked).

To test Java applet and ActiveX scanning:

1. Click HTTP > Applets and ActiveX > Policies from the main menu.
2. If necessary, select Enable Applet/ActiveX security and click Save.
3. Click Applet/ActiveX Security Global Policy.
4. On the Java Applet Security Rules tab, click Block all Java applets and click 

Save.
5. On the ActiveX Security Rules tab, click Block all cabinet files and Block all 

PE format files and click Save.
6. Open a Web browser and attempt to navigate to Web sites that use Java applets 

and ActiveX controls, for example, for stock price tickers or games. IWSS will 
block the mobile code from downloading and running in your browser.

Note: Blocking all Java applets and ActiveX controls may be too restrictive for your 
environment since it will prevent many legitimate Web sites from functioning 
properly. After testing, Trend Micro recommends going back to the Applets and 
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ActiveX Policy: Edit Global Policy screen to change the settings back to the 
default or your own less-restrictive configuration.

Testing IntelliTunnel Security
To test IntelliTunnel security:

1. Download the latest MSN Messenger from 
http://get.live.com/messenger/overview

2. Install MSN Messenger.
3. Enable IntelliTunnel in IWSS.

a. Click HTTP > IntelliTunnel and select the Enable IntelliTunnel check 
box. 

b. Create a new policy or open an existing one.

c. Select MSN Messenger.

d. Click Save.

e. Select the policy and then click Deploy Policies.

4. Configure proxy settings in Internet Explorer.
a. Open Internet Explorer.

b. Click Tools > Internet Options.

c. Click the Connections tab.

d. Click LAN Settings.

e. Select Use a proxy for your LAN. These settings will not apply to dial-up 
or VPN connections.

f. Enter the IWSS IP address in the Address field.

g. Enter the IWSS HTTP listening port in the Port field. This value must 
match HTTP > Configuration > Proxy Scan Settings > HTTP Listening 
Port in IWSS.

h. Click OK and then OK again.

i. Close Internet Explorer.
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5. Log in to MSN Messenger.
An error message should appear stating that you were not able to sign into MSN 
Messenger at this time.

6. Allow Microsoft Messenger (MSNP protocol). 
a. Click HTTP > IntelliTunnel.

b. Open the policy.

c. De-select Microsoft Messenger (MSNP protocol).

d. Click Save.

e. Select the policy and then click Deploy Policies.

7. Login to MSN Messenger.
MSN Messenger should now work.

Note: MSN Messenger uses the proxy configuration in Internet Explorer, so this test 
should be valid without requiring any modifications to firewalls, network, etc. 
Other IM applications may not honor the proxy configuration in Internet Explorer 
and only fall back to port 80 if the standard port is blocked.
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Tuning and Troubleshooting
This appendix explains the following:
• IWSS Performance Tuning starting on page C-2

• LDAP Performance Tuning starting on page C-2
• Troubleshooting starting on page C-5

• Troubleshooting Tips starting on page C-5
• Before Contacting Technical Support starting on page C-5
• Installation Problem starting on page C-5
• General Feature Problem starting on page C-6
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IWSS Performance Tuning
Trend Micro recommends you install IWSS on a computer with high CPU speed and 
fast disk operation since IWSS performs numerous file operations and computations. 
If you are experiencing issues with slow browsing performance, consider the 
following modifications and the IWSS remote rating service.

LDAP Performance Tuning
When running IWSS to use the user/group name via proxy authorization 
identification method (LDAP), HTTP proxy performance becomes dependent upon 
the responsiveness of the LDAP directory server. In a worst case scenario, every 
HTTP request would require an LDAP query to authenticate the user's credentials, 
and another to retrieve group membership information for that user. These queries 
introduce latency in terms of the transmit/receive delay between IWSS and the 
LDAP server, and add load to the LDAP server itself.

LDAP Internal Caches
To reduce the amount of LDAP queries required, IWSS provides several internal 
caches:
• User group membership cache: This cache can store the group membership 

information for several hundred users. By default, entries in this cache will be 
valid for 48 hours, or until the cache fills (at which point entries are replaced, 
starting with the oldest). The time to live (TTL) for entries in this cache can be 
configured via the setting “user_groups_central_cache_interval” in the 
[user-identification] section of intscan.ini configuration file.

• Client IP to User ID cache: This cache associates a client IP address with a user 
who recently authenticated from that same IP address. Any request originating 
from the same IP address as a previously authenticated request will be attributed 
to that user, provided the new request is issued within a configurable window of 
time (15 minutes by default for HTTP, 90 minutes for ICAP) from that 
authentication. The caveat is that client IP addresses seen by IWSS must be 
unique to a user within that time period, thus this cache is not useful in 
environments where there is a proxy server or source NAT between the clients 
and IWSS, or where DHCP frequently reassigns client IPs. To enable or disable 
this cache, change the “enable_ip_user_cache” setting in the [user-identification] 
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section of intscan.ini. To change the TTL of this cache, change the 
“ip_user_central_cache_interval” (unit is hours). For example, to create a TTL of 
30 minutes, then enter “0.5”.

• User authentication cache: This avoids re-authenticating multiple HTTP requests 
passed over a persistent connection. When users pass the credential validation 
over a persistent connection, IWSS adds an entry (two important keys in one 
cache entry are the client’s IP address and the client’s username) in the user 
authentication cache so the subsequent requests over a keep-alive connection will 
not authenticate again. The client IP address and client’s username serve as two 
forward references, or links, to the “client IP to user ID cache” and “user group 
membership cache,” respectively. IWSS will thus still be able to retrieve the 
user’s connection information from both the IP-user and user-group caches.

When deploying IWSS with LDAP integration, it is important to consider the 
additional load that authenticating HTTP requests will place on the LDAP directory 
server. In an environment that cannot effectively use the client IP to user ID cache, 
the directory server will need to be able to handle queries at the same rate as IWSS 
receives HTTP requests.

Disable Verbose Logging When LDAP Enabled
Trend Micro recommends turning off verbose logging in the intscan.ini file, under 
the [http] section, “verbose” parameter) when LDAP is enabled for server 
performance reasons. Verbose logging is primarily used by software developers to 
identify abnormal application behavior and troubleshooting. In a production 
deployment, verbose logging is usually unnecessary.

If verbose logging is enabled and LDAP is also enabled, IWSS will log user 
authentication information and group membership information in the HTTP log in 
the \Log folder. Logs may contain hundreds of lines per user and therefore 
significantly consume disk space, depending on the amount of internal traffic and the 
number of groups a user is associated with. Verbose logging keeps the service busy 
with issuing I/O operations to the operating system. This may prevent the service 
from responding to HTTP requests in a timely fashion, hence latency may occur. In 
an extreme bursting HTTP traffic environment, it’s possible to observe significant 
delays when IWSS starts up in verbose mode.
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TCP/IP Stack Tuning
By default, there are some TCP/IP stack limitations in Windows. In order to allow 
IWSS to perform efficiently under heavy network traffic load, tune the TCP/IP stack 
by modifying the following values using regedit. 

Note: After you have made the changes, you must restart your computer to make the 
changes take effect. 

MaxUserPort
Controls the max port number that TCP can assign. Every unique client making a 
request to your web server will use up at least one of these ports on the server. 

HKLM\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters

Type: DWORD

Value: 65534

TCPTimedWaitDelay
Determines the time that must elapse before TCP can release a closed connection and 
reuse its resources. This interval between closure and release is known as the 
TIME_WAIT state or 2MSL state. 

HKLM\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters

Type: DWORD

Value: 60
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Troubleshooting

Troubleshooting Tips
• Issue: IWSS could not connect to the database specified in the Database 

Connection Settings page. The IWSS management console displays the 
following error message:

JDBC-ODBC BRIDGE: [Microsoft][ODBC SQL Server Driver][Shared 
Memory]SQL Server does not exist or access denied.

Solution: 
• Please check the ODBC connection and/or database server and try again.

• Issue: The IWSS management console displays an authentication error message.

JDBC-ODBC BRIDGE: [Microsoft][ODBC SQL Server Driver][SQL 
Server]login failed or user 'sa', The user is not associated 
with a trusted SQL Server connection. 

Solution: 
• Verify the user credential for the SQL Server and also ensure that the 

database settings are correct (Administration > IWSS Configuration > 
Database | Database Setting). If the problem persists, ensure that the login 
account user name and password for the SQL server are correct.

Before Contacting Technical Support
When contacting Technical Support with your issues, having specific information 
can streamline the process:

Installation Problem
Collect the following information about your installation problem before contacting 
Trend Micro technical support to expedite the process.
1. IWSS version and build number
2. Screenshot of the exact error that appears during installation
3. The stage of the installation / un-installation where the problem occurs 
4. The C:\IwssInstLog\iwssinst.log installation log file
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General Feature Problem
If you have problems with IWSS, collect the following information to give to Trend 
Micro support:
1. The system file(s) that describes the current state of IWSS.

To compile these files, access the Web console and choose Administration > 
Support and then click Generate System Information File. This button is an 
extension of the case diagnostic tool (CDT), allowing you to package the current 
machine “state” at a click of a button. 
The system file(s) that IWSS generates from clicking the Generate System 
Information File button are packaged into a single file with the following 
format:
CDT-YYYYMMDD-HHmmss.zip

Where YYYY is the current year, MM is the current month, and DD is the current 
day, HH is the current hour, mm is the current minute, and ss is the current 
second that the package file was generated. 
The system file(s) contains the following information:
• IWSS information—Includes IWSS product version, engine version and 

build number, current pattern file (if available), and IWSS hot fixes and 
service pack information. Product and integration settings are also part of 
this information

• IWSS/system logs—Includes IWSS logs and debug logs, logs generated by 
daemon (if system logs are enabled), and dump file 

• System/network information—Includes the hardware configuration, 
operating system, build, system resource status, other application installed, 
and network information

• CDT-compliant configuration/plug-ins information—Includes 
information about changes made to CDT 

2. Dump files are created in the directory listed below: 

\Program Files\Trend Micro\InterScan Web Security 
Suite\userdumps

Use these files when working with Trend Micro technical support to help 
diagnose the cause of your problem. To view the files yourself, use a program 
like winDbg.
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3. Log file for the day the issue occurred
• All log files the day the issue occurred (logs are stored in %IWSS_HOME% 

/log by default)
• Make sure verbose=1 is set in the [ftp], [http], and [notification] sections 

of the intscan.ini file
• Make sure log_trans=yes is set under the [http] section of the 

intscan.ini file
4. From the Web console, take a screenshot of the Summary > Scanning tab page.
5. Record the IWSS version number.
6. URL samples (if applicable).
7. Get a packet capture of the failing transaction using ethereal.
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                                                                             Appendix D 

Troubleshooting, Maintenance and 
Technical Support

This appendix explains the following:
• Product Maintenance on page D-3
• Contacting Technical Support on page D-5
• Security Information Center on page D-8
• About Trend Micro on page D-10
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Troubleshooting
This section provides tips for dealing with issues you may encounter when using 
IWSS. 

After changing the archive directory using the Web console, new audit trail logs 
are not stored in the new directory. 

After you have changed the log directory in the Web console, you must restart the 
"Trend Micro InterScan Web Security Suite Console" service on the IWSS computer 
to make the changes take effect

No traffic information is available for a category in the Traffic Reports > Top 
Categories (weighted) screen.

When you set IWSS as the proxy for itself and visited a Web site (such as 
www.google.com) and enable real-time traffic report, the IWSS will not show any 
traffic information for the Web site you have visited. This is because of the way 
IWSS categorizes Web sites and the database does not store traffic information Web 
site access through the self-proxy setup.

After changing the archive log directory in the Web console, my Web browser is 
unable to connect to the Web console 

When you set the IWSS computer as the proxy and change the log directory, HTTP 
connection may be disrupted. To resolve this issue, restart the HTTP service to make 
the changes take effect. You may need to refresh your Web browser.
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Product Maintenance
From time to time, Trend Micro may release a patch for a reported known issue or an 
upgrade that applies to your product. To find out whether there are any patches 
available, visit the following URL:

http://www.trendmicro.com/download/

The Update Center screen displays. Select your product from the links on this screen:

Clicking the link for InterScan Web Security Suite takes you to the Update Center 
page for IWSS. Scroll down to review the patches that are available. 

Patches are dated. If you find a patch that you have not applied, open the readme 
document to determine whether the patch applies to you. If so, follow the installation 
instructions in the readme.

Maintenance Agreement 
A Maintenance Agreement is a contract between your organization and Trend Micro, 
regarding your right to receive technical support and product updates in 
consideration for the payment of applicable fees. When you purchase a Trend Micro 
product, the License Agreement you receive with the product describes the terms of 
the Maintenance Agreement for that product.

A license to the Trend Micro software usually includes the right to product updates, 
pattern file updates, and basic technical support (“Maintenance”) for one (1) year 
from the date of purchase only. After the first year, Maintenance must be renewed on 
an annual basis at Trend Micro’s then-current Maintenance fees. 

Note: If the Maintenance Agreement expires, your License Agreement will not.

If the Maintenance Agreement expires, scanning can still occur, but the product 
cannot be updated, even manually. Also, you will not be entitled to receive technical 
support from Trend Micro. 

Typically, ninety (90) days before the Maintenance Agreement expires, you will be 
alerted of the pending discontinuation. You can update your Maintenance Agreement 
by purchasing renewal maintenance from your reseller, Trend Micro sales, or on the 
Trend Micro Online Registration URL: 
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https://olr.trendmicro.com/registration/ 

Renewing Your Maintenance Agreement 
Trend Micro or an authorized reseller provides technical support, virus pattern 
downloads, and program updates for one (1) year to all registered users, after which 
you must purchase renewal maintenance.

If your Maintenance Agreement expires, scanning will still be possible, but virus 
pattern and program updates will stop. To prevent this, renew the Maintenance 
Agreement as soon as possible. 

To purchase renewal maintenance, contact the same vendor from whom you 
purchased the product. A Maintenance Agreement, extending your protection for a 
year, will be sent by post to the primary company contact listed in your company’s 
Registration Profile. 

To view or modify your company’s Registration Profile, log on to the account at the 
Trend Micro online registration Web site:

https://olr.trendmicro.com/registration 

You are prompted to enter a logon ID and password. 

To view your Registration Profile, type the logon ID and password created when you 
first registered your product with Trend Micro (as a new customer), and then click 
Log on.
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Contacting Technical Support 
To contact Trend Micro Technical Support, visit the following URL:

http://kb.trendmicro.com

Then, click the link for one of the following regions:
• Asia/Pacific
• Australia and New Zealand
• Europe
• Latin America
• United States and Canada

Follow the instructions for contacting support in your region.

In the United States, Trend Micro representatives can be reached via phone, fax, or 
email. Our Web site and email addresses follow:

http://www.trendmicro.com

support@trendmicro.com

For regional contact information and the specific technical support numbers for all 
the regional and worldwide offices, open the IWSS management console and 
choosing Support from the menu in the management console’s banner. 

General US phone and fax numbers follow: 

Voice: +1 (408) 257-1500 (main)

Fax: +1 (408) 257-2003

Our US headquarters is located in the heart of Silicon Valley:

Trend Micro, Inc.
10101 N. De Anza Blvd.
Cupertino, CA 95014

TrendLabs
TrendLabs is Trend Micro’s global infrastructure of antivirus research and product 
support centers that provide up-to-the minute security information to Trend Micro 
customers.
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The “virus doctors” at TrendLabs monitor potential security risks around the world, 
to ensure that Trend Micro products remain secure against emerging risks. The daily 
culmination of these efforts are shared with customers through frequent virus pattern 
file updates and scan engine refinements.

TrendLabs is staffed by a team of several hundred engineers and certified support 
personnel that provide a wide range of product and technical support services. 
Dedicated service centers and rapid-response teams are located in Tokyo, Manila, 
Taipei, Munich, Paris, and Lake Forest, CA, to mitigate virus outbreaks and provide 
urgent support.

Knowledge Base
The Trend Micro Knowledge Base is a 24x7 online resource that contains thousands 
of do-it-yourself technical support procedures for Trend Micro products. Use 
Knowledge Base, for example, if you are getting an error message and want to find 
out what to do to. New solutions are added daily. 

Also available in Knowledge Base are product FAQs, hot tips, preventive antivirus 
advice, and regional contact information for support and sales. 

Knowledge Base can be accessed by all Trend Micro customers as well as anyone 
using an evaluation version of a product. Visit: 

http://kb.trendmicro.com

And, if you can't find an answer to a particular question, the Knowledge Base 
includes an additional service that allows you to submit your question via an email 
message. Response time is typically 24 hours or less. 

Known Issues 
Known issues are features in your IWSS software that may temporarily require a 
workaround. Known issues are typically documented in section 7 of the Readme 
document you received with your product. Readme files for Trend Micro products, 
along with the latest copies of the product manuals, can also be found in the Trend 
Micro Update Center:

http://www.trendmicro.com/download/ 

Known issues can be found in the technical support Knowledge Base: 
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http://kb.trendmicro.com 

Trend Micro recommends that you always check the Readme file for information on 
known issues that could affect installation or performance, as well as a description of 
what’s new in a particular release, system requirements, and other tips. 

Sending Suspicious Code to Trend Micro
You can send your viruses, infected files, Trojans, suspected worms, spyware, and 
other suspicious files to Trend Micro for evaluation. To do so, visit the Trend Micro 
Submission Wizard URL:

http://subwiz.trendmicro.com/SubWiz 

Click the “Submit a suspicious file/undetected virus” link. The following screen 
displays.

You are prompted to supply the following information:
• Email: Your email address where you would like to receive a response from the 

antivirus team.
• Product: The product you are currently using. If you are using multiple Trend 

Micro products, select the product that has the most effect on the problem 
submitted, or the product that is most commonly in use.

• Number of Infected Seats: The number of users in your organization that are 
infected.

• Upload File: Trend Micro recommends that you create a password-protected zip 
file of the suspicious file, using the word “virus” as the password—then select 
the protected zip file in the Upload File field.

• Description: Please include a brief description of the symptoms you are 
experiencing. Our team of virus engineers will “dissect” the file to identify and 
characterize any risks it may contain and return the cleaned file to you, usually 
within 48 hours. 

Note: Submissions made via the submission wizard/virus doctor are addressed promptly 
and are not subject to the policies and restrictions set forth as part of the Trend 
Micro Virus Response Service Level Agreement.
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When you click Next, an acknowledgement screen displays. This screen also 
displays a case number for the problem you submitted. Make note of the case number 
for tracking purposes.

If you prefer to communicate by email, send a query to the following address:

virusresponse@trendmicro.com

In the United States, you can also call the following toll-free telephone number:

(877) TRENDAV, or 877-873-6328

Security Information Center
Comprehensive security information is available over the Internet, free of charge, on 
the Trend Micro Security Information Web site:

http://www.trendmicro.com/vinfo/

Visit the Security Information site to:
• Read the Weekly Virus Report, which includes a listing of risks expected to 

trigger in the current week, and describes the 10 most prevalent risks around the 
globe for the current week

• View a Virus Map of the top 10 risks around the globe
• Consult the Virus Encyclopedia, a compilation of known risks including risk 

rating, symptoms of infection, susceptible platforms, damage routine, and 
instructions on how to remove the risk, as well as information about computer 
hoaxes

• Download test files from the European Institute of Computer Anti-virus Research 
(EICAR), to help you test whether your security product is correctly configured

• Read general virus information, such as:
• The Virus Primer, which helps you understand the difference between 

viruses, Trojans, worms, and other risks
• The Trend Micro Safe Computing Guide
• A description of risk ratings to help you understand the damage potential for 

a risk rated Very Low or Low vs. Medium or High risk
• A glossary of virus and other security risk terminology

• Download comprehensive industry white papers
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• Subscribe, free, to Trend Micro’s Virus Alert service, to learn about outbreaks as 
they happen, and the Weekly Virus Report

• Learn about free virus update tools available to Webmasters
• Read about TrendLabs, Trend Micro’s global antivirus research and support 

center
To open Security Information:

1. Open the IWSS management console.
2. Click Security Info from the drop-down menu at the top-right panel of the 

screen. The Security Information screen displays.
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About Trend Micro 
Trend Micro, Inc. is a global leader in network antivirus and Internet content security 
software and services. Founded in 1988, Trend Micro led the migration of virus 
protection from the desktop to the network server and the Internet gateway–gaining a 
reputation for vision and technological innovation along the way.

Today, Trend Micro focuses on providing customers with comprehensive security 
strategies to manage the impacts of risks to information, by offering centrally 
controlled server-based virus protection and content-filtering products and services. 
By protecting information that flows through Internet gateways, email servers, and 
file servers, Trend Micro allows companies and service providers worldwide to stop 
viruses and other malicious code from a central point, before they ever reach the 
desktop.

For more information, or to download evaluation copies of Trend Micro products, 
visit our award-winning Web site:
http://www.trendmicro.com
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